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CHAPTER 1
GETTING STARTED

This chapter provides instructions for starting and exiting Qbit-DB™ and 
describes the different areas and the functions performed at the main 
window.

Starting/exiting Qbit-DB

Do one of the following to start Qbit-DB:

• Click [Start], select Programs, click Cubiscan, then click Qbit-DB.

• Double-click the Qbit-DB desktop icon. 

The main window is displayed.

Do one of the following to exit Qbit-DB:

• Pull down the File menu, and click [Exit].

• Click the Close button ([X]) located in the upper right corner of the 
main window.

Menu bar

The menus at the top of the main window contain functions used to 
perform tasks and set up Qbit-DB. Click a menu name and the menu drops 
down from the menu bar. Click a function on the menu to select it. If a 
function has an arrow on the right, a sub menu is displayed when you click 
the function.

You can also select a function by typing the first letter in the function name.

File menu

Following are the functions available on the File menu.
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Import Use this function to manually import data from an external source file. Refer 
to “Importing to a database table” on page 113.

Export Use this function to export all or a portion of the Qbit-DB database to an 
FTP site, an ASCII text file, or a csv file. Refer to “Exporting a database 
table” on page 115.

Exit Use this function to exit Qbit-DB.

Database menu

Following are the functions available on the Database menu.

New table Select this function to create a new database table. Refer to “Creating a 
new database” on page 109.

Open table Select this function to open an existing database table. Refer to “Opening 
a database” on page 110.

Delete table Select this function to delete a database table. Refer to “Deleting a 
database” on page 111.

Empty table Select this function to empty or clear the database table that is currently 
open. Refer to “Emptying a database” on page 112.

Save copy as Select this function to make a copy of the entire MS Access database and 
tables by creating a backup file from the Cubiscan.accdb MS Access 
database file.

Default column
order

Select this function to arrange the database columns in their default order.

Delete current
record

Select this function to delete the current highlighted record. You can also 
tap the delete button on the keyboard to delete individual item numbers 
from the database table.

Log database
field names

Select this function to store all the current database table field names in 
the log file.

View menu

Cubiscan picture Click this function to show or hide the Cubiscan picture window. A 
checkmark indicates it is shown.
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Stacking Click this function to show or hide the stacking window. A checkmark 
indicates it is shown.

Message Click this function to show or hide the message window. A checkmark 
indicates it is shown.

Camera image Click this function to show or hide the camera image window. A checkmark 
indicates it is shown.

Previous
measurement

Click this function to show or hide the previous measurement window. A 
checkmark indicates it is shown.

QR code Click this function to show a window displaying an item’s associated QR 
code.

Cubiscan fields
read only

Click this function to make the Cubiscan fields read only. With this function 
selected, you will not be able to make entries or edit information in any of 
the Cubiscan fields.

Database fields Click this function to show or hide the database fields. A checkmark 
indicates they are shown.

Load default view If you have changed the arrangement of windows on the main window (see 
“Customizing the main window” on page 13), select this function to return 
it to the default view.

Save as default
view

If you have changed the arrangement of windows on the main window (see 
“Customizing the main window” on page 13), select this function to save 
the new arrangement as the default view.

NOTE Saving a new default view will erase the factory setting default view.

Lock view If you have changed the arrangement of windows on the main window (see 
“Customizing the main window” on page 13), select this function to “lock” 
the position of the windows so that it cannot be moved. Select Unlock view 
to unlock them.

Data History Provides searchable information that can be viewed in the Data History 
Overview or downloaded as an on-hand report. See “Data History Viewer” 
on page 136.

Tools menu

Following are the functions available on the Tools menu. The Zero, Status, 
Test mode, Values, and Calibrate functions may not be available 
depending on whether or not the functions are available on the selected 
Cubiscan model.
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Zero Use this function to “zero” the Cubiscan. Refer to “Zero” on page 119. This 
function is not available when the Cubiscan™ 50, 200B, 200TS, 210, or 225 
is selected.

Status Use this function to verify that the Cubiscan is operating properly. Refer to 
“Status” on page 120. This function is not available when the Cubiscan™ 
30, 50, 200B, 200TS, 210, or 225 is selected.

Test mode Use this function to set up the Cubiscan for testing purposes. Refer to “Test 
mode” on page 122.

Values Use this function to display a table of sensor values that can be useful for 
troubleshooting the Cubiscan. Refer to “Values” on page 123. This function 
is not available when the Cubiscan™ 50, 200B, 200TS, 210, or 225 is 
selected.

Options Use this function to configure Qbit-DB. Configuration options include 
selecting your Cubiscan model, determining the measurement units, 
setting up import and export options, setting up user-defined fields, 
setting up a password, and so on. Refer to Chapter 2 “Configuration” on 
page 16 for details.

Actions menu

Following are the functions available on the Actions menu.

Swap length for
width

Select this function to switch the length and width measurement values for 
the current item.

Swap width for
height

Select this function to switch the width and height measurement values for 
the current item.

Swap height for
length

Select this function to switch the height and length measurement values for 
the current item.

Request weight This function is used for testing purposes.

Web service
errors

This function allows you to view and access error files and refresh, transfer, 
or delete the files. See “Error records” on page 106. 

Reports menu

Following are the functions available on the Reports menu.
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Detail Select this function to generate a report that lists all information in the 
currently loaded database table. The report can be viewed on screen or 
printed. Refer to Chapter 6 “Reports” on page 132.

Label Select this function to generate a label that can be printed. For information 
on customizing this label, see “Label report” on page 132.

NOTE
The label function is only available if the Enable label report printing field 
is enabled under Tools > Options > Reports.

Help menu

Following are the functions available on the Help menu.

About Select this function to display the current version and build of Qbit-DB and 
information about Cubiscan.

Languages menu

From this menu you can choose from the following languages.

• Chinese (PRC)

• Danish

• English

• French

• Japanese

• Korean

• Portuguese (Brazil)

• Russian 

• Spanish
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Main window

When Qbit-DB starts, the main window is displayed and either an empty 
database table with the default name “ITEM_INFO” or the last database 
table that was opened is loaded.

All recorded measurement data is saved in the open database table. You 
can open a different database if necessary. Refer to Chapter 3, “Database 
Management” for information.

The following functions are performed at the main window:

• Measure and weigh objects (see Chapter 5 “Measuring Objects” on 
page 125).

• Add/update database entries (see “Database window” on page 12).

• Access all other Qbit-DB functions using the menus (see “Menu bar” 
on page 1).

The main window is divided into several windows, as described in the 
following sections. You can move, resize, or hide some windows to make it 
easier to view only what you need (refer to “Customizing the main window” 
on page 13).

Figure 1
Main window
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Stacking window

The stacking window can be used to stack similar items that fall beneath 
the minimum measuring requirements. Individual dimensions will be 
calculated and stored in the database. Refer to Chapter 5, “Measuring 
Objects” for information.

Figure 2
Stacking window
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Measurement window

The measurement window contains all of the fields and buttons you use to 
measure the length, width, height, weight, and other appropriate data.

Entry fields The fields in which you can make an entry include the primary or Item 
Number field (which can only be edited before the measurement is taken), 
the secondary field if it is enabled, the Description field if it is enabled, any 
user fields that have been enabled, and the object’s measurement and 
weight entries. Some fields are enabled or disabled using the Options on 
the Tools menu (refer to Chapter 2 “Configuration”).

The item number may be selected by scanning a label, or entered manually 
as you measure the object. You can select an item in the database table to 
edit its measurement fields. You can edit any field that is not disabled. Click 
in a field to edit it, and type over the existing entry. Then click [Update] (or 
press <F4>) to update the information in the database.

Repeat item
number

If you have enabled the secondary field (see “Secondary field” on 
page 21), this button is enabled. You can use it to make an additional 
database entry with the same item number (or other primary field 
descriptor) so that you can add another item with the same number and a 
secondary descriptor to make it a unique item.

Figure 3
Measurement window
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User fields The user fields section contains user-defined fields. These are fields that 
can be set up to meet your specific requirements. When enabled, these 
fields are available for entry and can be edited in the main window. Refer to 
“User fields” on page 54 for information.

Cubiscan
fields

The dimensions and weight of the object are entered as each item is 
measured with the Cubiscan. You can also enter or edit the entries in the 
Length, Width, Height, and Weight fields (if Cubiscan fields read only is 
not selected in the View menu).

Database
fields

These fields display the information of previously measured items or item 
information that was imported into the database. You can compare the 
imported item information to the item information in the Cubiscan fields to 
make sure the measurements have been updated in the database. You can 
remove these boxes from the measurement window by selecting View > 
Database Fields.

Measurement
buttons

The measurement buttons include the buttons you will use to measure 
objects with the Cubiscan, as follows.

Click the [Measure] button to measure the object on the Cubiscan.

Click the [Update] button to update the current item record. You must 
update a record (or “clear” it) before you can measure a new item.

Click the [Clear] button to clear the data fields for the current item and start 
over.

Click the [Delete] button to delete the current record. (This button must be 
enabled; refer to “Enable record delete button” on page 24.)

Cubiscan picture window

After you specify the Cubiscan model to which your computer is connected 
(refer to “Cubiscan” on page 18), a simulation of the Cubiscan is displayed 
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in the picture window. After you measure objects, the object and its 
measurements are also shown.

Camera image window

The camera image window displays the image that was taken of the object. 
For more information on this feature see “Images” on page 64.

If no image is available the window displays the message “No Image”.

This window can be placed in one of the docking positions on the main 
window or it can be left to float. To move the window click in the top left 
corner.

Figure 4
Cubiscan picture window

Figure 5
Camera image window
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Previous measurement window

This window displays the measurement information of the previous item 
that was measured. This feature can be used with in-motion Cubiscan 
systems, such as the Cubiscan™ 200-TS, 210-SS, or the 210-DS.

This window can be placed in one of the docking positions on the main 
window or it can be left to float. To move the window click in the top left 
corner.

QR Code window

This window displays a scannable QR code for each measured item. The 
code contains embedded data about the item. See “QR Code” on 
page 89 for instructions on configuring which content is embedded and its 
format. 

Message window

The message window lists any Cubiscan activity and gives the status of the 
activity. This includes any configuration changes, measurements taken, and 
error messages.

Figure 6
Previous measurement window

Figure 7
Message window
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Database window

The database window lists the items in the open database. The columns 
and number of items visible may depend on how you have moved and 
resized the windows in the main window. You can also resize and rearrange 
the columns in the database view (see “Customizing the database 
window” on page 13).

Right clicking on a grid column will hide or unhide the column. Double 
clicking on the column header will sort the table on that column in 
ascending order. Double clicking in the same column header again will sort 
the table by that column in descending order.

Moving
through the

database
window

Use the horizontal scroll bar to move left and right through the columns 
and the vertical scroll bar to move up or down through the items in the 
database.

Use the arrow buttons to move up and down through the items, as follows.

Click to move to the first item in the database.

Click to move up one item at a time.

Click to move down one item at a time.

Click to move to the last item in the database.

Selecting an
item

Click an item to select it for measurement or remeasurement or to display 
the object’s measurements and weight in the measurement window.

You cannot edit the fields in the Database view. To edit an item, click it to 
select it, then edit the data in the measurement fields. To update the line in 
the Database view with the new information, click [Update] (or press <F4>).

Figure 8
Database window
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Customizing
the database

window

You can change the position and size of the columns in the database view, 
and you can sort the items by any column as follows:

• To change the position of a column in the table, click on the heading 
and drag it to a new position.

• To change the width of a column, move the mouse pointer over the 
side of the column heading until the pointer changes to directional 
arrows. Click and hold the mouse button, and drag the side of the 
column until it is the size you want, then release the mouse button.

• To sort by the entries in a column, click the column heading. Click 
once to sort in descending order; click again to sort in ascending 
order.

• To return the Database view to its default set up, pull down the Data-
base menu, and click Default column order.

Refer to Chapter 3, “Database Management” for information on managing 
databases.

Customizing the main window

You can move, resize, or hide some windows of the main window to 
customize the display. The measurement window cannot be moved and 
acts as a point of reference for all of the other Qbit-DB windows.

• The stacking window, Cubiscan picture window, message window, 
camera image window, previous measurement window, and data-
base window can be resized.

• The stacking window, Cubiscan picture window, message window, 
camera image window, and previous measurement window can be 
separated from the main window and moved to a different docking 
position or left to float on the screen.

• The stacking window, Cubiscan picture window, message window, 
camera image window, previous measurement window, and Data-
base fields can be hidden or shown.

Resizing To resize a window, hover the mouse over any side or corner until the 
pointer changes to directional arrows. Click and hold the mouse button, 
and drag the side or corner of the window until it is the size you want, then 
release the mouse button.

NOTE You can resize the entire main window using the same method.
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Moving Each window that can be separated has a “docking bar” at the top when 
the window is docked, or in a fixed position, in the window.

To move the window, click the docking bar, hold down the mouse button, 
and drag the window to another location in the window. As you drag it, you 
will see an outline that indicates the position and size it will be. When it is in 
the position you want, release the mouse button. If you move a window to 
a floating, or undocked, position, the docking bar changes to a title bar. To 
move a floating window, click the title bar, hold down the mouse button, 
and drag the window. When you move it into a docked position, the 
docking bar appears again.

Docked positions are on either side of the measurement window.

Hiding/
Showing

To hide the stacking window, Cubiscan picture window, message window, 
camera image window, previous measurement window, or the Database 
fields (in the measurement window), pull down the View menu, and click 
the window you want to hide. Pull down the menu and click it again to 
show a hidden window.

You can also click the [X] on the docking bar or title bar of the stacking 
window, Cubiscan picture window, or message window. To show the 
window again, select it from the View menu.

Saving a view After you have customized the view of the main window, you can lock the 
windows into place, save the new arrangement as the default view, or 
return to the default view. Pull down the View menu, and select a function, 
as follows:

• Load default view
Select this function to return the main window to the default view.

• Save as default view
Select this function to save the new arrangement as the default view.

• Lock view
Select this function to “lock” the position of the windows so they 
cannot be moved. Select Unlock view to “unlock” the windows.
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Status bar

The Status bar is located at the bottom of the main window and provides 
the following information.

Name of the currently loaded database table.

Currently selected record number and the total number of records.

Whether or not the records have been updated. Until a record is updated, 
the label reads: “Updated records = 0.” After one or more records are 
updated, it reads: “Updated records = xx” (where xx is the total number of 
updated records in the current database).

Move the mouse over a menu or function, and a description of the menu or 
function is displayed.

If you scheduled an automatic import (see “Auto export” on page 44), the 
number of hours/minutes/seconds to the next import is displayed. If you 
have not set up auto import, “Next import: Disabled” is shown.

If you scheduled an automatic export (see “Auto export” on page 44), the 
number of hours/minutes/seconds to the next export is displayed. If you 
have not set up auto export, “Next export: Disabled” is shown. Right 
clicking on the auto import or auto export will manually start the 
import/export process.
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CHAPTER 2
CONFIGURATION

This chapter provides information and instructions to configure and set up 
defaults for Qbit-DB using the Tools > Options function. The following tabs 
contain the configuration options:

•“Cubiscan” on page 18
Setup the measurement and dimensional weight units, select the 
Cubiscan communications port, select your Cubiscan model, and 
enter a site ID (optional).

•“Database” on page 20
Setup primary, secondary, description, and database fields, as well as 
other database options. This tab also contains the option to convert 
an older Qbit-DB database to the new format.

•“Database connection” on page 26
Define the connection name and schema name. This is also where 
you can format the time and date of the database information.

•“Password” on page 27
Setup password security for selected functions.

•“Import” on page 29
Select import options, set up the layout of the imported database 
fields, and set up the automatic import function.

•“Export” on page 36
Select export options, set up the layout of the exported database 
fields, and set up the automatic export function.

•“Factors” on page 53
Enter the values used for dimensional weight factors.

•“User fields” on page 54
Setup from one to eight user-defined fields.

•“Tolerances” on page 57
Setup tolerance values, validation options, or validation events.

•“Orientation” on page 60
Setup the orientation settings of measurements.

•“Login” on page 62
Setup user ID options and settings. 
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•“Images” on page 64
Setup a network or digital camera with Qbit-DB. Configure captured 
image file names and setup automatic file transfers. 

•“Reports” on page 78
Setup label report printing and select label setup options.

•“Nesting” on page 80
Enable nesting and select nesting settings. This tab is not available 
when the Cubiscan™ 200TS, 210, or 225 is selected.

•“ODBC” on page 81
Enable open database connectivity to connect your database to 
Cubiscan’s database.

•“Maintenance” on page 85
Enable database maintenance to remove records older than a set 
number of days.

•“Scale” on page 86
Enable a weight trigger to cause an automatic weight measurement 
to occur. 

•“QR Code” on page 89
Set the format and content to generate QR codes for each measured 
item.

•“Web services” on page 92
Enable and configure web services

Select Options from the Tools menu to open the Options dialog box. Refer 
to the following sections for information on the options in each tab. Click 
[OK] to save changes you made to any tab and exit the dialog box. Click 
[Cancel] to exit without saving.

The User fields tab has a unique saving mechanism, for more information, 
see “Select user field” on page 64.
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Cubiscan

Click the Cubiscan tab to set up the measurement and dimensional weight 
units, select the Cubiscan communications port, select your Cubiscan 
model, and enter a site ID (optional).

Unit of measure options

Dimension units Select the measurement units you want used to measure length, width, and 
height dimensions: Inches, Millimeters, or Centimeters.

Weight units Select the units you want used for package weights: Ounces, Pounds, 
Grams, or Kilograms.

Volume units Select the units you want used to measure volume: Cubic inches, Cubic 
feet, Cubic millimeters, Cubic centimeters, Cubic decimeters, or Cubic 
meters.

Figure 9
Cubiscan tab
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Dimensional
weight units

Select whether you want to use Domestic or International dimensional 
weight units. Refer to “Factors” on page 53 for information on setting up 
dimensional weight factors.

Cubiscan options

Communication
ports

Select which method you will use to connect your Cubiscan to a computer. 
The options are: RS-232 serial port, Network port, or USB port 
(depending on which Cubiscan model is selected). If you are using the 
serial port, enter the PC port #. If you are using the Network port, enter the 
IP address and the IP port.

Cubiscan model

Select the model of Cubiscan you are using. Options in some tabs may vary 
depending on the Cubiscan model selected. In addition, the Cubiscan 
measuring display and the menus and functions available in the main 
window will change to match the selected model.

The “T” Model is the touchscreen model for the Cubiscan™ 100, 110, and 
150, 225. If you have the touchscreen model for one of these Cubiscans, 
enable this field when selecting your model. If you select one of these 
models, a new USB port option appears under the communications ports 
section.

Site ID

If measurement data from your site will be exported and merged with 
measurement data from other sites, you may want to assign a “Site ID” 
number to each site to identify the site that supplied the data. If used, the 
site ID number is shown in the “Site ID” column in the database table.

Enter an identification code for your site using any alphabetic or numeric 
characters but no symbols or spaces.
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Database

Click the Database tab to set up database fields, options, and tare values. 

Primary field

The primary field is the first field in the editable fields section of the main 
window with Item number as the default label.

The primary field receives an item’s identification number, whether typed, 
scanned, or selected from an imported data file. The following options 
allow you to customize this field:

Field name By default, the primary field label is Item number. Type a new name in the 
text box to change the label. The new label replaces Item number in the 
main window and in the database window.

Figure 10
Database tab
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Enable
cross-reference

lookup within
optional info

fields

Enabling this function allows the primary field to be populated with a 
cross-referenced value. For more information on this function, see  
“Measuring items with cross reference lookup enabled” on page 129.

Enabled
red/green
highlight

Enabling this function displays a green background for located records and 
a red background for records not found.

Enable
notification when
primary field not

found

Enabling this function displays a message after a user enters a primary field 
value that is not found in the database.

Field length Enter the maximum number of characters that can be entered in the key 
field (from 1 to 100). You will not be allowed to enter more than the 
specified number of characters in the field.

Key field option This option can be used to limit the type of characters that can be entered 
in the primary field to help prevent data input errors. Select the option for 
the type of characters to be allowed in the key field: Any character, Alpha 
numeric characters, Alphabetic characters, or Numeric characters. If you 
do not want to define any restrictions, select Any character.

Secondary field

In addition to the primary field, you can enable a secondary field that can 
be used to enter an additional descriptor under the primary field label. For 
example, you can enter a product number in the primary field and then 
enter a pack type in the secondary field.

Field name Type a field name in the text box to change the label. The new label 
appears in the main window and in the database window.

Enable secondary
field

Select this option to enable the secondary field. When this field is enabled 
a new [Repeat item number] button appears above the [Measure] button 
in the measurement window.

If you click the [Repeat item number] button after measuring an item, it will 
automatically identify the same item number as the previous measurement. 
It will then automatically select the next item in the secondary field 
drop-down list (if applicable). It will also update the description and user 
field values.

Hide field Select this option to hide the secondary field in the main window.
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Allow manual
entry in addition

to drop-down list

After you enable the secondary field, you can enter a drop-down list of 
items or descriptions from which to choose at the secondary field on the 
main window. Select this option if you want to be able to make a manual 
entry in the secondary field in addition to selecting from the drop-down 
list.

Auto-fill
drop-down list

from existing data

This option overrides the secondary drop-down list and imports a 
drop-down list from a specified import file. For more information on 
importing a file, see  “Export” on page 36.

This will also provide a “result set” to choose from within the secondary 
drop-down list values when you enter an item number into the primary 
field.

Secondary field
drop-down list

Click in the text box and enter a list of items. Press <Enter> after each 
item. The items entered become available for selection from a drop-down 
list in the secondary field on the main window.

Database options

The database options determine how items are entered in the database 
and whether or not you can delete item records.

Data mode

The following options determine how information is entered into the 
database.

Add/Update
items

Select this option if you want to add items to the database more often than 
you update existing items. This makes adding items the default, and a 
warning message appears when you update an existing item.

Item records are identified by the descriptors in the primary field (generally 
item number) and the secondary field if it is enabled. You cannot add an 
identical item to a database, but you can change and update an item.

If the secondary field is not enabled, an identical item is any item with the 
same item number. If the secondary field is enabled, an identical item is 
any item with the same item number and the same secondary field entry.
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If you attempt to add an identical item, the following warning message is 
displayed.

Select [Yes] to overwrite the existing item or [No] if you did not intend to 
change the existing item.

Verify item exists
before update

Select this option if you update existing items or import data in a database 
more often then you add new items. This option is used with its 
sub-options to give you multiple variations, as follows.

Allow new items to be added (enabled)

If this option is enabled, updating existing items is the default, but items 
can also be added to the database.

Allow new items to be added (disabled)

If this option is not enabled, you can only update existing items; you 
cannot add new items. If you attempt to add a new item, the following 
warning is displayed.

Auto advance through items

Select this option if you generally measure items in the order they are listed 
in the existing database. If enabled, after you select the first item, Qbit-DB 
automatically moves down the list in sequential order as each item is 
measured and updated. However, you can also manually click an item to 
select it if necessary.

The database window can be sorted by the entries in a column by clicking 
on the column heading. For more information, see “Customizing the 
database window” on page 13.

Allow duplicates Select this option if you want to allow duplicate item numbers to exist in 
the same database. 

When you select this option, item numbers can no longer be updated or 
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edited.

Selecting this option also causes the Replicate last scan function to appear 
under the Actions menu. Selecting this function will allow you to make 
duplicates of an item number in your database.

When you select Replicate last scan the following window appears.

This window shows the item number and all of its associated information. 
To replicate the item number, enter the desired value into the field and 
click [Replicate].

A warning window will appear, asking if you are sure that you want to 
replicate. If you do want to replicate, click [Yes]. If you do not want to 
replicate, click [No].

NOTE
Selecting this option also removes the Import tab found in the Tools > Options 
window.

Auto update Select this option if you want Qbit-DB to automatically store item 
information in the database. You only need to enter the item number and 
click [Measure]. You do not need to click the [Update] button.

Auto update
delay (ms)

Select this option if you want the auto update feature to be delayed by the 
amount of time you enter into the field (in milliseconds).

Enable record
delete button

Select this option if you want to be able to delete an item record from the 
database. The [Delete] button in the main window becomes available; 
otherwise, it is grayed.

Tare values

Tare values are preset dimensions to be subtracted from a measurement. If 
a tare value is included and the resulting measurement or weight is less 
than zero, the reading will be zero.

Tare values are not used in most applications but may be used in some 
circumstances.
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Enable tare
option

If you use tare values all or part of the time, click this option to enable tare. 
If enabled, two new options appear on the Actions menu.

The Apply tare values (or <Ctrl><T>) applies the tare values to the current 
measurement.

The Enable automatic tare (or <Ctrl><Alt><T>) automatically applies the 
tare values to each measurement until it is disabled.

Length
Width

Height
Weight

Enter tare values for measurements and weight as applicable. Each 
specified value is subtracted from the dimension measurement or weight. 

Show error on
zero

Select this function if you want Qbit-DB to alert you if an item number’s 
measurement information is zero (or less than zero) once the tare values 
have been applied.

Description field

Enable field Select this option to enable the Description field in the main window 
(under the primary and secondary fields). You can then enter a description 
for each item, which will appear in the database table.

Include this field
when repeating

Select this option if you want the item description included when you 
repeat an item number. (Repeat is only available if the secondary field is 
enabled; refer to “Secondary field” on page 21.)

Hide field Select this option if you do not want the Description field displayed in the 
main window.
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Database connection

On this tab, you can define the connection name and schema name. This is also 
where you can format the time and date of the database information.

Master data
connection

definition

Connection name: This is the default name that was created from the 
software install, or the name that was created using the FireDac 
Administrator utility. (see Appendix C “Firedac administrator” on 
page 167). 

Schema name: This is the schema definition associated with the database 
and may be needed to access certain database tables. If included, the 
schema name should include the “.” at the end of the name.

Enable database login dialog: Check box to enable the login dialog 
whenever accessing the database.

Start FireDac Administrator: Click [Start FireDac Administrator] to launch 
the FireDac Administrator utility.

Use encrypted database password: Check box to enable the use of an 
encrypted password when accessing the database.

Figure 11
Database Connection
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Password encryption: Enter the password to be used when encrypted 
database password is enabled.

NOTE
When clicking [Save], the password text will be removed and an application restart 
will be required.

Consult your database administrator for details on requirements for 
connecting to your database.

Database
time/date format

Here you can set your preferred time and date format using the examples 
shown. You can also leave the field blank for default formatting based upon 
your computer’s regional settings.

Password

To provide security for specified functions in Qbit-DB, you can set up a 
password. Once a password is set up, the selected functions are dimmed in 
the menus and only become available when the password is entered. The 
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Options function is always included when password protection is enabled 
for any function.

Password options Select the functions for which a password will be required. Options include: 
zero, calibrate, import, export, sort on column, new table, open table, 
delete table, empty table, and unlock view.

Set password Click this button to set up or change the password. The following dialog 
box is displayed.

In the Enter password box, type the password. In the Re-enter password 
box, type it again for verification. The password is case sensitive; if you 

Figure 12
Password tab
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enter upper or lower case characters, they must be entered in the same 
case when entering the password. Click [OK] to accept the password.

When you attempt to access a function that has been password protected, 
the following prompt appears.

Enter the password exactly as it was entered when set up (case sensitive), 
and click [OK] to open the function.

Clear password Click [Clear password] to remove an existing password. This allows access 
to all functions by all users. The message: “Password cleared” is displayed. 
This means that a password is no longer required to use any functions in 
Qbit-DB. Click [OK].

Import

Import type

Import file type

Select the type of file you want to import. The options are delimited, and 
fixed length.

Import file includes header information

Select whether or not the file you want to import has header information.

Import merge options

This option allows you to select how to handle existing and new items 
when doing an import.

Append only: Selecting Append only will allow new items to be added, but 
existing items will not be updated.
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Update only: Selecting Update only will allow existing items to be updated 
without adding new items.

Append/Update: Selecting Append/Update will allow existing items to be 
updated while adding new items.

Import delimited file

Use this option to select the delimiter type for your file. You can select 
comma, tab, or other. When selecting other, be sure to identify the import 
file delimiter in its field.

Import fields contain double quotation marks around character strings

Check box to toggle option for importing character strings with or without 
double quotations.

Import file delimiter

Enter in the text box below the header the character used for delimiting 
values in the imported data. The default is a comma.

Date format

Enter an alternative date formate that to override the imported date 
format. Use “/” or “-” to separate day, month, and year. Use the following 
to set format:

year = YYYY

month = MM

day = DD

Import layout

The data being imported must be mapped to the fields in the database 
table. 
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First, load a sample file of the data to be imported. Alternatively, preloaded 
default fields. Refine table field choices by selecting options from the 
dropdown list for each field.

Use the left and right arrows to navigate between records. Click [Clear all] 
to clear all the table fields. After values are entered, click [OK] to save 
settings.

Auto Import

On this tab, you can set up automatic importing. To do this, enter the file 
location and name, select the frequency options, the times, or intervals for 
importing. You can also select the options to import at program startup, 
prompt for confirmation when importing, and deleting the file after auto 
import.

Import file location and name

Enter the location path of the file to be imported or click [Browse...] to 
select the file from the Browse window.

Figure 13
Import Layout
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Import frequency options

Import mode Select the mode for automatic importing, as follows.

Off
Select this option to disable automatic import.

Import at specified time of day
Select this option to set up a time of day to import the file. The Import 
times options become available to set up the time(s) of day for import.

Import at specified time interval
Select this option to set up a time interval to import the file. The Import 
interval timer options become available to set up the time interval for 
import.

Import times If you selected Import at specified time of day, this section is available to 
set up the time of day you want the file exported.

You can set up four different times to export a file. Select Enable Time 1 to 
enter the first export time. Then type the time of day in the Time 1 text box 
in a 12-hour clock format (i.e., 1:00 AM, 2:00 PM, and so on). Do the same 
to set up times 2 through 4 as required.

The database file will be exported automatically every day at the specified 
time or times until you disable the time.

Import interval
timer

If you selected Import at specified time interval, this section is available to 
set up the interval timer.

Click the arrow buttons to scroll up or down from 00 to 23 hours, 00 to 59 
minutes, and 00 to 59 seconds. Click once to scroll one at a time, or click 
and hold to scroll quickly through the numbers in sequence.
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The database file will be imported automatically at the specified time 
intervals. For example, if you select 2 hours, the file will be imported every 
2 hours.

Import at program
startup

If you enable this function, the file will be imported automatically each time 
Qbit-DB starts up. 

Prompt for
confirmation

when importing

If you enable this function, Qbit-DB will prompt you for confirmation when 
a file is about to be imported.

Delete file after
auto import

If you enable this function, Qbit-DB will delete file after it is auto imported.

FTP download

The FTP download tab is used by Cubiscan when importing files 
downloading via FTP (File Transfer Protocol).

FTP download options

Select whether you want to download the import file from a host using FTP 
or an ASCII text file. You can select one or the other or both options.

Activate FTP
download

Select Activate FTP download to activate the FTP download option. 
Enabling this option allows you to edit and select options in the FTP 
section.
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Set up the options to download the file from a host via FTP. You can obtain 
this information from your network administrator.

FTP Enter the login information required by your network for file transfer.

User ID
Enter a valid user ID (required for upload access to the host site).

Password
Enter a valid password (required for upload access to the host site).

Remote host
Enter the name of the FTP host (e.g., ftp.host.com)

Remote port
Enter the port used for the transfer, normally “21”.

Remote path
Enter the directory path on the host. Be sure to use the correct syntax for 
the server type (e.g., \...\ or /.../).

Figure 14
FTP Download
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Protocol Type
Select protocol type form the drop down menu. Options include: FTP, 
sFTP, FTPs (implicit SSL), FTP-ES (SSL 3.0 or TLS 1.0). 

If you are unsure which protocol you will need, consult your network 
administrator.

Transfer mode Select the file transfer method.

ASCII
Select this option if you want the file to be imported in ASCII (plain text) 
mode.

Binary
Select this option if the file contains formatted text, non-text characters, or 
other data not interpreted as text.

Network mode Select your network mode.

Passive
Select this option if your network uses passive FTP.

Active
Select this option if your network uses active FTP.

PPK key file Enter the location path for the private key or browse for it by clicking the 
[Browse] button. The private key file must be in .ppk format.

Remote file
transfer

completion

Choose what you would like Qbit-DB to do with the imported file after it is 
downloaded via FTP.

Delete file on remote server
Once the file is successfully downloaded from the remote host the file will 
be deleted.

Rename file on remote server
Once the file is successfully downloaded from the remote host the file will 
be renamed with prefix “Done-”.

Move file to another remote server archive location
Once the file is successfully downloaded from the remote host the file will 
be moved to an archive folder on the remote server.

Remote path
archive location

Enter the directory path where you would like files to be archived. Be sure 
to use the correct syntax for the server type (e.g., \...\ or /.../).

Local destination
folder

Select the local folder for downloading. You may enter the local address or 
click [Browse] to bring up the browsing window and select the folder you 
wish to download to.
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Importing bad records

When importing data some files may not transfer correctly (e.g., Qbit-DB 
does not recognize the data, files are corrupted, data was not mapped 
properly, etc.). When this happens Qubit-DB will give an error message 
totaling the number of files that did not import correctly.

These files are saved in a text file called Import error records.txt found in 
the Cubiscan folder. By default, the Cubiscan folder will be in the root 
directory. You can also search for the folder in File Explorer.

Export

The Export option on the File menu is used to export data to an external 
ASCII text file or upload it via FTP (File Transfer Protocol). (Refer to 
“Exporting a database table” on page 115 for information.) Click the 
Export tab to set up the export options, the layout of the exported 
database fields, and the automatic export function.
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Export type

Select the Export type tab to set up the options that define the type of files 
that can be exported.

Export file type

Select the file type to be used when exporting database files. The default is 
delimited.

Delimited Variable length, delimited files (.csv or .txt file extension) contain variable 
length records, each separated by a carriage return/line feed pair. Fields 
may vary in length and are separated by field separators. Leading and 
trailing spaces for numeric and character fields are truncated. The format of 
date fields depends on your Windows regional settings. If you select this 
option, additional options to define the delimiter type become available at 
the bottom of the tab.

Fixed length Fixed length files (.txt file extension) contain fixed length records, each 
separated by a carriage return/line feed pair. Fields are fixed in length with 
no field separators. Character fields are padded with trailing blanks, and 

Figure 15
Export type
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numeric fields are padded with leading blanks. The format of date fields 
depends on your Windows regional settings.

JSON and XML The JSON and XML exports will follow the same process as the text file 
export with the following exceptions.

1. All data will be stored in memory before it is written to disk. Because of 
this, it is not recommended to export large amounts of data.

There is a built-in internal check every 1000 records to see how much 
internal memory has been used and will terminate the export process if it 
reaches 1.5GB.

2. The element and tag names will always be stored using the physical 
database table field names and are always upper case. (See example 
below.)

3. The root element and entry point will be called “DATA”. For XML, the 
array parent tag will be “ITEM”.

4. Whether there is one record or multiple records being exported, they 
will always be stored in an array or nested format. (See example below.)

5. All duplicate fields from the export layout will be ignored.

6. All “SPACE FILLER” from the export layout will be ignored.
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JSON format using an example of an export layout as defined in the 
Export layout tab.
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XML format using an example of an export layout as defined in the Export 
layout tab.
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JSON
customizable

format

As with the JSON and XML outputs, all data will be stored in memory 
before it is written to disk. Because of this, it is not recommended to export 
large amounts of data.

The customizable JSON is manually defined in the “JSON custom 
format.txt” file using control tags to create the desired JSON output 
format.  “Customizable JSON format” on page 99.

Export header information

Select Yes if you want to include header information in the file when it is 
exported. Select No if you do not want to include it.

Export delimited file

Select export options for delimited file types.

Delimiter type This option is only available if you selected “Delimited” as the export file 
type. Select the delimiter type used in the text file: Comma, Tab, or Other. 
If you select Other, enter the delimiter in the Export file delimiter box. 

Add double
quotation marks

around character
strings

Select this option if you want quotation marks placed around character 
strings in the exported file. The double quotation marks will keep the 
characters within the quotation marks together in the export file.

Export layout

You can change the layout of the database table for the export file. You can 
select which fields you want included, change the length of the field, 
change the decimal point location, or even rearrange the fields. You must 
set up the Export type options before you change the layout (see “Export 
type” on page 37). Do the following to set up the fields in the database 
table for export.
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Select the Export layout tab.

Click [Load defaults] if you want to export the database as it appears in 
Qbit-DB, or to display all of the fields in the database table so that you can 
edit the layout.

Click [Clear all] to clear all of the fields from the layout list.

Click a table field and then click [Remove] to remove the field from the 
exported database.

Click a table field and then click [Insert] to insert a field above the selected 
field.

Click a table field and then click [Move up] to move the selected field up 
one position in the table.

Click a table field and then click [Move down] to move the selected field 
down one position in the table.

Figure 16
Export layout
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Click the drop-down arrow at a table field to display a list of available fields 
and select a field name to add or change a field. Options may differ from 
those shown to reflect user defined fields.

NOTE
The “SPACE FILLER” option in the drop-down list can be used to specify an empty 
or blank field.

If you specified fixed length as the file type in the Export type tab, click in 
the second column next to a field to change the starting position (in 
number of characters) of the field.

If you specified fixed length as the file type in the Export type tab, click in 
the Size column next to a field to change the number of characters in the 
field.
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Click in the Decimals column for a field to add or change the number of 
characters after the decimal point for entries in the field. This applies to 
decimal fields only (e.g., dimensions, weight, and volume).

Auto export

To set up Qbit-DB to automatically export a file at a time of day, at 
specified time intervals, or after every update, click the Auto export tab. 

NOTE You must set up the Export type options and the Export layout before you set 
up auto export (see “Export type” on page 37 and “Export layout” on 
page 41). 

After you set up an auto export, the number of hours/minutes/seconds to 
the next scheduled export is displayed in the status bar of the main window 
(see “Main window” on page 6).

Click the Frequency tab to set up the time(s) to export the file, then click 
the Destination tab to select the type of output.

NOTE
The options in the Destination tab are not available until you select a frequency 
option in the Frequency tab. 
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Frequency

Click the Frequency tab to set up the mode and times to export.

Export frequency options

Select how often a file will be exported.

Export mode

Select the mode for automatic exporting, as follows.

Off Select this option to disable automatic export.

Export at
specified time of

day

Select this option to set up a time of day to export the database file. The 
Export times options become available to set up the time(s) of day for 
export.

Export at
specified time

interval

Select this option to set up a time interval to export the database file. The 
Export interval timer options become available to set up the time interval 
for export.

Figure 17
Auto export, frequency
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Export after each
update

Select this option to automatically export the current database file each 
time it is updated. No other options are necessary in this tab if you select 
this option.

Export times

If you selected Export at specified time of day, this section is available to 
set up the time of day you want the file exported.

You can set up four different times to export a file. Select Enable Time 1 to 
enter the first export time. Then type the time of day in the Time 1 text box 
in a 12-hour clock format (i.e., 1:00 AM, 2:00 PM, and so on). Do the same 
to set up times 2 through 4 as required.

The database file will be exported automatically every day at the specified 
time or times until you disable the time.

Export interval timer

If you selected Export at specified time interval, this section is available to 
set up the interval timer.

Click the arrow buttons to scroll up or down from 00 to 23 hours, 00 to 59 
minutes, and 00 to 59 seconds. Click once to scroll one at a time, or click 
and hold to scroll quickly through the numbers in sequence.

The database file will be exported automatically at the specified time 
intervals. For example, if you select 2 hours, the file will be exported every 2 
hours.
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All data or updated data

If you selected a time of day or time interval for the export, select whether 
you want to export All data in the database or only the Updated data.

Export at program
shutdown

If you enable this function, the database file will be exported automatically 
each time Qbit-DB is shutdown. 

Prompt for
confirmation

when exporting

If you enable this function, Qbit-DB will prompt you for confirmation when 
a database file is about to be exported.

Destination

Click the Destination tab to set up the type of output for the export file.

Figure 18
Auto Export, Destination
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Export destination options

Select whether you want to upload the export file to a host using FTP or 
output the file to an ASCII text file. You can select one or the other or both 
options.

Activate FTP
Upload

Select Activate FTP Upload to activate the FTP upload option. This option 
is only available when you have selected an Export Mode from the 
Frequency tab. Enabling this option allows you to edit and select options in 
the FTP section.

Set up the options to upload the database file to a host via FTP when it is 
exported automatically. You can obtain this information from your network 
administrator.

FTP Enter the login information required by your network for file transfer.

User ID
Enter a valid user ID (required for upload access to the host site).

Password
Enter a valid password (required for upload access to the host site).

Remote host
Enter the name of the FTP host (e.g., ftp.host.com)

Remote port
Enter the port used for the transfer, normally “21”.

Remote path
Enter the directory path on the host. Be sure to use the correct syntax for 
the server type (e.g., \...\ or /.../).

Figure 19
Auto Export, Destination, FTP
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Protocol Type
Select protocol type form the drop down menu. Options include: FTP, 
sFTP, FTPs (implicit SSL), FTP-ES (SSL 3.0 or TLS 1.0). 

If you are unsure which protocol you will need, consult your network 
administrator.

Transfer mode Select the file transfer method.

ASCII
Select this option if you want the file to be exported in ASCII (plain text) 
mode.

Binary
Select this option if the file contains formatted text, non-text characters, or 
other data not interpreted as text.

Network mode Select your network mode.

Passive
Select this option if your network uses passive FTP.

Active
Select this option if your network uses active FTP.

Private key file Enter the location path for the private key or browse for it by clicking the 
[Browse] button. The private key file must be in .ppk format.

Activate export file output

Select this option to output the exported data to an ASCII text file.

Export file options
Enter a directory path and complete file name for the exported file in the 
File Location and Name text box, or click [Browse].

Browse to the folder in which you want to save the file. If you want to write 
over or append to an existing file, select the file name; if you want to create 
a unique file, enter a file name in the File Name field (including the 
extension, which can be any ASCII text file extension, e.g., .txt, .csv). Click 
[Save]. The path and file name are inserted in the Destination Folder field.
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Output mode
Select the option you want to use to create the exported file.

Overwrite existing file
Select this option to overwrite a previously uploaded file.

Append data to file
Select this option to append (add) the uploaded file to an existing file.

Export file name

Click the Export file name tab to select the auto export file name 
convention settings.

Export file name format

Select the auto export file name conventions from the following options.

Prefix 1-5 You can select five prefixes that make up the auto export file name. Prefix 1 
is a mandatory field and must have an option selected. From these 

Figure 20
Auto Export, Export File Name
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drop-down fields you can select various fields from Qbit-DB that will be 
used to make up file names. The options available are: (None), Pack type, 
Optional info 1, Optional info 2, Optional info 3, Optional info 4, Optional 
info 5, Optional info 6, Optional info 7, Optional info 8, Site ID, Static text, 
and Date and Time.

NOTE
Prefix options may differ from the default to reflect user defined fields. 

File name prefix
separator

You can select the symbol that will separate the file name prefixes from the 
following options: None, -(Dash), _(Underscore), or +(Plus).

Static text
You can enter any desired text here that you want included in auto export 
file names. To add the static text to the file name, select Static Text in one 
of the Prefix 1-5 drop-down lists. 

NOTE
File names can’t contain the following characters: \ / : * ? ” < > |

Date & Time
You can enter the date and time here. To add the date and time to the file 
name, select Date & Time in one of the Prefix 1-5 drop-down lists. The 
acceptable date & time formats are found below the Date & Time field.

File name extension 
You can enter the file name extension here.
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FTP file name

Click the FTP file name tab to select the FTP file name convention settings.

FTP file name format

Select the FTP file name conventions from the following options.

Prefix 1-5 You can select up to five prefixes that make up the FTP file name. Prefix 1 is 
a mandatory field and must have an option selected. From these 
drop-down fields you can select various fields from Qbit-DB that will be 
used to make up file names. The default options available are: (None), 
Pack type, Optional info 1, Optional info 2, Optional info 3, Optional info 
4, Optional info 5, Optional info 6, Optional info 7, Optional info 8, Site 
ID, Static text, and Date and Time.

NOTE
Prefix options may differ from the default to reflect user defined fields. 

File name prefix
separator

You can select the symbol that will separate the file name prefixes from the 
following options: None, -(Dash), _(Underscore), or +(Plus).

Figure 21
Auto Export, FTP File Name
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Static Text
You can enter any desired text here that you want included in FTP file 
names. To add the static text to the file name, select Static text in one of 
the Prefix 1-5 drop-down lists.

NOTE
File names can’t contain the following characters: \ / : * ? “ < >

Date & Time
You can enter the date and time here. To add the date and time to the file 
name, select Date & Time in one of the Prefix 1-5 drop-down lists. The 
acceptable date & time formats are found below the Date & Time field.

File Name Extension 
You can enter the file name extension here.

Factors

Click the Factors tab to enter or edit the domestic and international 
dimensional weight factors. A dimensional weight is calculated for each 
measurement (both domestic and international).

Figure 22
Factor tab
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Dimensional weight factors

An item’s dimensional weight is its density based on volume and is 
calculated using the following equation:

Dimensional Weight = Length * Width * Height / Factor

Defaults Click [Defaults] to use the default values provided by Cubiscan. Or, click in 
each text box and enter your own values for each factor.

User fields

User fields are labeled User field 1 through User field 8 by default, 
however, you can customize the labels. These fields can be used to enter 
any additional information about an item into the database.

Use the following options to customize one or more user fields. 

Figure 23
User Fields tab



Configuration User fields

Qbit-DB 55

Select user field

Select the user field that you would like to edit. You must save the changes 
made at each field using the [Save Changes] button before moving on to 
the next field. If you make a change to a user field and forget to save, you 
will be prompted to save your changes.

If you are only editing one user field, you can simply click [OK] after you 
have made your changes and the changes will automatically be saved.

NOTE
User field 8 is numeric only.

User field attributes

Select the attributes of user fields 1-8.

Requirements

Setup the requirements for the selected user field.

Field name Type a label for the field. The label is displayed in the place of the User 
field default label in the main window and as the column heading in the 
database table.

Field length Enter the maximum number of characters that can be entered in the field 
(from 1 to 60). You will not be allowed to enter more than the specified 
number of characters in the field. Default values will be shortened to fit the 
specified field length.

Enable field Select this option to enable the user field. Once enabled, the field 
becomes available after the item number is entered and remains available 
until the record is updated. You cannot make this field mandatory or 
include it when repeating unless it is enabled. You cannot hide this field if it 
is enabled. 

Mandatory entry Select this option if you want an entry to the field to be mandatory. A valid 
entry will be required in the field before the item record can be updated.

Include this field
when repeating

Select this option if you want the user field included when you repeat an 
item number. (Repeat is only available if the secondary field is enabled; 
refer to “Secondary field” on page 21.)

Hide field Select this option to hide a disabled user field in the main window.
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Use default text Select this option if you want a default or static value to appear in the 
selected user field.

Default or static
text

Type a default value for the field. This value will appear by default in the 
selected user field. If both the Enable field and Use default text fields are 
enabled, the default will appear in the user field but can be overridden by 
manual entry.

You can also disable the Enable field option while using a default value. 
Doing this will enable you to use the default value and not allow it to be 
edited during the cubing and weighing process.

If you are using a default value with a drop-down list, your default value 
must also be listed among the drop-down values. The Enable field option 
must also be enabled.

Data entry option

This option can be used to limit the type of characters that can be entered 
in the field to help prevent data input errors. Click the option for the type 
of characters to be allowed: Any character, Alpha numeric characters, 
Alphabetic characters, Numeric characters, Y/N character (yes/no), or 
Drop-down list. If you do not want to define any restrictions, select Any 
character.

If you select Drop-down list you will be required to enter the desired values 
into the box that appears to the right of the Data entry options.

Alphabetic character option

This option can be used to restrict the type of alphabetic characters that 
are entered in the field to help prevent data input errors. Click the option 
for the type of alphabetic characters to be allowed: Mixed case, Upper 
case, or Lower case.

Ensure that your alphabetic character option does not interfere with your 
Data entry option. For example, if you select alpha numeric characters for 
your data entry option and upper case as your alphabetic character option 
you will be unable to enter any lower case options into the selected user 
field.

This section may be grayed out depending on the data entry option that 
was selected.
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Tolerances

Click this tab to enable tolerance checking. This is the tab where you can 
set your exclusion criteria. You can set a Max or Min value for the length, 
width, height, weight, or volume of an item’s measurements. You can also 
set an Allowed difference tolerance, which is the difference allowed 
between an item’s current dimension versus the new dimension that has 
been manually inputed or received from the Cubiscan.

Enable tolerance
checking

Enabling this function allows Qbit-DB to validate new item numbers and 
item numbers that are updated against the tolerance values.

Tolerance values

The tolerance values for Length, Width, Height, Weight, and Volume can 
be entered into the columns of the table.

To enable a tolerance value, complete the following steps.

Figure 24
Tolerances tab
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1. Enable the Enable tolerance checking field.

2. Enter the desired tolerance values into the appropriate field in the 
Tolerance values table. 

You can enter a Max, Min, or Allowed difference value for the length, 
width, height, weight, or volume of an object.

3. Enable the corresponding fields located below the Tolerance values 
table. These fields must be enabled for the tolerance values that were 
entered into the Tolerance Values table to be checked.

If one of these fields is enabled without a corresponding tolerance 
value being entered into the Tolerance values table an error will display 
after attempting to Measure or Update an item.

Validation options

The Validation options field is where you can enable and disable various 
validation options.

Allow errors to be
overridden

Enabling this field allows you to override tolerance exceptions that are 
found.

Turn off message
dialog

notifications

Enabling this field turns off the tolerance exception notifications.

Clear
measurement
data on errors

Enabling this field will clear all the measurement data when tolerance 
exceptions are found.

Bypass update
when item is in

tolerance

Enabling this field will allow the system to bypass updating the database 
when items are in tolerance. This means that if you attempt to update and 
change an item’s measurements the system will not retain the changes if 
the measurements are within the tolerance values. When this option is 
enabled, the Validation event field is grayed out.
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Validation event

The Validation Event field allows you to select when you would like the 
system to check for tolerance exceptions.

After clicking
“Measure” button

Selecting this field will prompt the Qbit-DB system to check for tolerance 
exceptions when the [Measure] button is clicked.

After clicking
“Update” button

Selecting this field will prompt the Qbit-DB system to check for tolerance 
exceptions when the [Update] button is clicked.

After clicking
“Measure”

or “Update”
button

Selecting this field will prompt the Qbit-DB system to check for tolerance 
exceptions when the [Measure] or [Update] button is clicked.
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Orientation

From this tab you can select the orientation settings of the Cubiscan’s 
measurements.

Dimension orientation

In this field you can enable automatic dimension orientation, select 
dimensions that should be excluded from the automatic option, and select 
dimension settings. The orientation tab settings occur when you click the 
[Measure] button.

Enable automatic
dimension
orientation

Enabling this field automatically sorts the item’s measurements according 
to the selections made in the drop-down length, width, and height 

Figure 25
Orientation tab
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dimension boxes. The message window will notify you of the automatic 
dimension orientation that took place. An example is shown below.

Dimensions Choose the parameters you would like to sort the data received from the 
Cubiscan to a specific orientation. For each dimension (length, width, and 
height), you can select from the values Don’t care, Shortest, Longest, or 
Exclude. 

Use the Don’t care option if you want to include a specific dimension in the 
comparison process, but do not need it sorted. 

Use the Exclude option to exclude a specific dimension from the sorting 
process.

Figure 26
Automatic dimension orientation
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Login

From this tab you can select a user ID and the field in which it will appear. 

Options

Select User ID options. After making these changes Qbit-DB must be 
closed and restarted for the changes to take effect.

User ID

Select your preferred User ID option from the following options. 

Off Select this option if you do not want Qbit-DB to prompt the user for an ID 
or password.

Figure 27
Login tab
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Capture Windows
user account ID

Select this option if you want Qbit-DB to capture your Windows user 
account ID and store it in the selected user field each time the [Update] 
button is clicked.

Prompt for user ID
at application

startup

Select this option if you want Qbit-DB to prompt the user to enter an ID 
each time Qbit-DB starts up.

Prompt for user ID
at application
startup using

drop-down list

Select this option if you want Qbit-DB to prompt the user to select an ID 
from the drop-down list each time Qbit-DB starts up. When you select this 
option a new field appears, called the User ID drop-down list. Enter the 
desired values into this field.

When this option is selected a new option appears under the Actions menu 
that allows you to change users. To change a user select Actions > Change 
user (<Ctrl><U>) and select the new user from the drop-down list. 

Prompt for user ID
and password at

application
startup

Select this option if you want Qbit-DB to prompt the user for an ID and 
password each time Qbit-DB starts up. When you select this option a new 
button called [Manage users/passwords] appears.

When this option is selected a new option appears under the Actions menu 
that allows you to change users. To change a user select Actions > Change 
user (<Ctrl><U>) and login using the desired user ID and password.

Click on this button to bring up the User/Password management window 
that is shown below.

Figure 28
User/Password Management Window
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Enter the user ID and password into the appropriate fields. You can select if 
the user will have administration rights, which allows the user to manage 
the user accounts. There must be at least one administration account.

The Existing users box shows all the current records of user IDs, passwords, 
and administration rights status. Passwords that are shown in this box are 
encrypted. You can arrow through or delete these records using the arrows 
found at the bottom of the Existing users box. 

To give a user administrative rights, toggle the Admin rights option next to 
the Password field.

NOTE Make sure that all records have an associated user ID and password, delete all 
incomplete records.

The Inactivity timer box is where you can select how often a user will be 
prompted to enter their ID and password. The options are None, 15 Min, 
30 Min, 45 Min, 60 Min, and 90 Min. Depending on which option was 
selected, the user will need to enter their information again if Qbit-DB is 
left inactive for the selected amount of time.

Use the [Add/Update user] button to add a user ID and password or to 
update an existing record. When you are finished, click [Exit].

Select user field

In this box you can select which user field you would like to correspond 
with a user ID. This user ID will be stored in the selected user field each 
time the [Update] button is clicked. The options available are User fields 
1-7, or None. When you select the user field that you wish to use, you will 
automatically be directed to the corresponding user field under the User 
Fields tab. For further information on the user field options, see “User 
fields” on page 54.

NOTE When selecting which user field you want associated with an ID, be sure that the 
user field you select is not already in use.

Images

From this tab you can enable a network or digital camera to work with 
Qbit-DB or select your image file options. Camera kits are available from 
Cubiscan to purchase.
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The images tab requires a camera to be connected to Qbit-DB. 

For information on installing a network camera, see “Parts list for the Axis 
network camera kit” on page 148.

For information on installing a digital camera, see “Digital camera options” 
on page 68.

For information on the Cubiscan 75 and 75 Pro cameras, see “Cubiscan 75 
camera options” on page 70.

Overhead Camera options

From this screen you can configure and select the settings for overhead 
camera.

Figure 29
Camera options
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Additional Cameras

The additional cameras tab allows for the configuration of additional 
network and custom Cubiscan cameras other than the overhead camera 
These include the Axis, the digital camera, and options specific to the 
Cubiscan 75 and 75 Pro. Note that the availability of certain cameras is 
dependent on the Cubiscan used.

Axis Camera Options

This field contains all the settings for the Axis camera.

Enable network
camera snapshots

Enable this field to allow a network camera to connect to Qbit-DB. 

A new [Snapshot] button will also appear in the measurement window. 
Click this button to take a snapshot.

Once a snapshot has been taken Qbit-DB automatically names and saves 
the file as a .jpg. To see the file name, use the arrows to scroll to the far 
right of the database window until you reach the Image file section. This 
section displays the file names of each snapshot taken. To select the image 
file name settings, see  “Click the Destination tab to set up the type of 
output for the image file.” on page 74.

If there are multiple snapshots associated with an item number, then 
Qbit-DB displays ?? in the file name, as shown below.

Camera setup

Select your network camera setup options.

IP address Enter the IP address in this field. The IP address that you should enter is 
printed on the Axis camera box. The default IP address setting is usually 
10.1.100.40, but check your Axis camera box to be sure.
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IP port number The IP port number should automatically be filled in.

Auto-snapshot
after measure

Enable this field if you want a snapshot to be taken automatically after you 
measure an item. 

Enable multiple
snapshots

Enable this field if you want to be able to take multiple snapshots of an 
item. 

Seconds to show
snapshot

In this field you can edit the number of seconds for which the snapshot is 
displayed in the camera image window after a snapshot has been taken.

Barcode scan event

Auto-snapshot
after barcode

scan

Check box to enable snapshots to be taken automatically after a barcode 
has scanned.

Seconds to delay
before taking

snapshot

Set a delay timer in seconds for snapshot to be taken. This is especially 
helpful to allow time for an operator to remove hand and barcode scanner 
from measurement area to ensure they do not end up in the snapshot.

NOTE
For the multiple snapshots function to work properly Qbit-DB needs to be closed 
and restarted when this field is enabled or disabled. 
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When you enable this option a new slide show view button appears at the 
bottom of the camera image window.

To view all the snapshots associated with an item number, click on Slide 
show view.

Use the [Prev] and [Next] arrows to scroll back and forth through the 
snapshots.

Click Live view to display the live feed from the camera.

When both Auto-snapshot after measure and Enable multiple snapshots 
are enabled at the same time only the first snapshot will be automatic. To 
obtain additional snapshots, click [Snapshot].

Digital camera options

This field contains all the settings for a digital camera.

Enable digital
camera snapshots

Enable this field to allow a digital camera to connect to Qbit-DB. 

Figure 30
Slide show view
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Auto-accept
image

Enable this field if you want the image you took to be automatically 
accepted. 

The default setting is that each image must be accepted or discarded 
before it will be saved to the item number that has been entered into the 
Item number field, as shown below. 

If multiple images are taken, each image will appear as the previous image 
is accepted or discarded by clicking the [Accept] or [Discard] buttons 
found at the bottom of the camera image window. 

If you enable Auto-accept Image then you will not need to accept or 

Figure 31
Auto-accept image disabled
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discard each image as it is taken. The [Accept] and [Discard] buttons are no 
longer available.

Enable multiple
snapshots

Enable this field if you want the system to allow multiple snapshots per 
item number.

When this function is enabled, two new buttons appear at the bottom of 
the camera image window. These buttons, [Prev] and [Next], allow you to 
scroll through all images that are associated with an item number.

If Auto-accept Image is not enabled, each image will need to be accepted 
or discarded before you can scroll through the images.

Repair multiple
snapshots broken

links

Repair any broken links for multiple snapshots by clicking [Start]. A 
dialogue box will appear informing you of the number of broken links 
repaired.

Cubiscan 75 camera options

This field contains all the settings for a Cubiscan 75 camera.

Enable Cubiscan
75 camera
snapshots

Enable this field to allow a Cubiscan 75 camera to connect to Qbit-DB. If 
you are using the Cubiscan 75 Pro, you must check the box next Cubiscan 
model 75Pro. 

This is to ensure that the Qbit DB software know which version of the 
Cubiscan 75 you are using. If this box is not checked errors will occur.

Figure 32
Auto-accept Image Enabled
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Auto transfer

To set up Qbit-DB to automatically transfer an image file at a certain time 
of day, at specified time intervals, or after every update, click the Auto 
transfer tab.

Select the Frequency tab to set up the time(s) to export the image files, 
select the Destination tab to determine where the image file will be 
transferred to, or select the Image file name tab to choose how your image 
file should be named.

Frequency

Select the Frequency tab to set up the mode and times to export.

Image file transfer
frequency options

Select how often an image file will be transferred.

Figure 33
Images, Auto Transfer, Frequency
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Transfer mode

Select the mode for automatic transfers, as follows.

Off
Select this option to disable automatic transfers.

Transfer at specified time of day
Select this option to set up a time of day to transfer the image file. The 
Transfer times options become available to set up the time(s) of day for 
transfer.

Transfer at specified time interval
Select this option to set up a time interval to transfer the image file. The 
Transfer interval timer options become available to set up the time interval 
for transfer.

Transfer after each update
Select this option to automatically transfer an image file every time the 
[Update] button is clicked.

Transfer times If you selected Transfer at specified time of day, this section is available to 
set up the time of day you want the file transferred.

You can set up four different times to export a file. Select Enable time 1 to 
enter the first transfer time. Then type the time of day in the Time 1 field in 
a 12-hour clock format (i.e., 1:00 AM, 2:00 PM, and so on). Do the same to 
set up times 2 through 4 as desired.

The image file will be transferred automatically every day at the specified 
time or times until you disable the Transfer at specified time of day 
feature.
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Transfer interval
timer

If you selected Transfer at specified time interval, this section is available 
to set up the interval timer.

Click the arrow buttons to scroll up or down from 00 to 23 hours, 00 to 59 
minutes, and 00 to 59 seconds. Click once to scroll one at a time, or click 
and hold to scroll quickly through the numbers in sequence.

The image file will be transferred automatically at the specified time 
intervals. For example, if you select 2 hours, the file will be transferred every 
2 hours.

Transfer at
program

shutdown

If you enable this function, the image file will be transferred automatically 
each time Qbit-DB is shutdown.

Prompt for
confirmation

when transferring

If you enable this function, Qbit-DB will prompt you for confirmation when 
a database file is about to be exported.
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Destination

Click the Destination tab to set up the type of output for the image file.

Image file destination options

Configure your image file destination options.

Activate FTP
upload

Select Activate FTP upload to activate the FTP upload option. This option 
is only available when you have selected a Transfer mode from the 
Frequency tab. Enabling this option allows you to edit and select options 
in the FTP section.

Set up the options to transfer the image file to a host via FTP when it is 
transferred automatically. You can obtain this information from your 
network administrator. 

FTP Enter the login information required by your network for file transfer.

User ID
Enter a valid user ID (required for upload access to the host site).

Figure 34
Images, Auto Transfer, Destination
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Password
Enter a valid password (required for upload access to the host site).

Remote host
Enter the name of the FTP host (e.g., ftp.host.com)

Remote port
Enter the port used for the transfer, normally “21”.

Remote path
Enter the directory path on the host. Be sure to use the correct syntax for 
the server type (e.g., \...\ or /.../).

Protocol Type
Select protocol type form the drop down menu. Options include: FTP, 
sFTP, FTPs (implicit SSL), FTP-ES (SSL 3.0 or TLS 1.0). 

If you are unsure which protocol you will need, consult your network 
administrator.

Network mode Select your network mode.

Passive
Select this option if your network uses passive FTP.

Active
Select this option if your network uses active FTP.

Private key file Enter the location path for the private key or browse for it by clicking the 
[Browse] button. The private key file must be in .ppk format.

Activate image
file output

Select this option to output the image file to a destination folder.

Image file options Enter a directory path to the folder you with to send the image file in the 
Destination Folder field, or click [Browse].

Browse to the folder in which you want to save the file. Click [Save]. The 
path and file name are inserted in the Destination Folder field.
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Image file name 

From this tab you can select the image file name convention settings.

Image file name format

Select the image file name conventions from the following options.

Prefix 1-5 You can select 5 prefixes that make up the image file name. Prefix 1 is a 
mandatory field and must have an option selected. The options available 
are Item number, pack Type, Option info 1-8, Site ID, Static text, and Date 
& Time.

NOTE
Prefix options may differ from the default to reflect user defined fields. 

File name prefix
separator

You can select the symbol that will separate the file name prefixes from the 
following options: None, -(Dash), _(Underscore), or +(Plus).

Static text You can enter any desired text here that you want included in image file 
names. To add the static text to the file name, select Static text in one of 
the Prefix 1-5 drop-down lists.

Figure 35
Images, Auto Transfer, Image File Name
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Date & time You can enter the date and time here. To add the date and time to the file 
name, select Date and time in one of the Prefix 1-5 drop-down lists. The 
acceptable date & time formats are found below the Date and time field. 
Using these formats will ensure that the file is saved with the correct 
information.

NOTE
The following characters are not allowed in the Prefix 1-5, Static Text, or Date and 
time fields: \ / : * ? < > 

2D images

From this screen you can enable 2D images.

2D image options

Enable the 2D image option if you would like to view the 2D image from 
the Cubiscan in Qbit-DB. The 2D image will be displayed in the Cubiscan 
picture window. Available on Cubiscan™ models 25, 75, 125, 225, and 325.

Figure 36
Images, 2D images
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NOTE
2D image capture must be enabled on Cubiscan to use this function.

Reports

Access this tab to enable label report printing and select label setup 
options. 

Figure 37
Reports tab
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Report options

This field contains label report settings.

Enable label
report printing

Enable this field to allow label reports to be printed.

Label setup
This field contains label setup options.

Label size Select the size of the label from the drop-down box. The sizes available are 
a 2x2, 3x3, 4x4, and a 4x6 inch label.

Printer name Select the printer that the label will print to. 

Copies Type in the number of labels that you want to print.

Auto print

None Select if you want to force manual printing.

After Update Select if you want a label to print each time you click [Update].

After Import Select if you want a label to print each time you import.

Dimension
rounding

Select the dimension rounding option that you prefer. This option will 
round the length, width, and height measurements to the option that you 
select. The options available are True rounding, Round up, and Round 
down.

Dimension digits
after the decimal

Type in the number of digits that you want to appear after the decimal on 
length, width, and height measurement dimensions.

Weight rounding Select the weight rounding option that you prefer. This option will round 
the weight measurement to the option that you select. The options 
available are True rounding, Round up, and Round down.

Weight digits
after the decimal

Type in the number of digits that you want to appear after the decimal on 
weight measurement dimensions.
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Nesting

From this tab you can view and change nesting settings. Enabling nesting 
will allow you to calculate and save the nesting factor of an item. The 
nesting feature should be used when you are measuring multiples of an 
item that can be stacked inside one another, like cups or Russian nesting 
dolls.

Enable nesting
functionality

Enable this field to allow for a nesting factor to be calculated and saved. 
When you enable this feature a new button appears on the home screen, 
called [Nesting] (the shortcut is <F11>). You may need to rearrange your 
main window to display the new nesting button. The [Nesting] button will 
appear below the [Delete] button.

Figure 38
Nesting tab
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Select user field

Select which user field will contain the nesting factor. The options available 
are user fields 1-7. Make sure you select a user field that is not already in 
use. When you select a user field you will be automatically directed to the 
User fields tab so that you can select the settings for the selected user 
field. See “User fields” on page 54 for more information on the options 
available for the user fields.

Calculating and saving a nesting factor

To calculate and save a nesting factor, complete the following steps:

1. Measure a single item. When the measurement process is complete, 
remove the item from the Cubiscan platform.

2. Place the nested item on the Cubiscan.

3. Click the [Nesting] button. The following window appears.

4. Enter the nested quantity into the field and select the nesting direction. 
The nesting direction refers to the direction that the items are stacked. 
When you are finished click [Calculate], press <F11>, or use the 
measuring gate to take a measurement. If you wish to quit without 
calculating the nesting factor, click [Cancel].

5. The nesting factor is calculated and placed in the selected user field.

6. Click [Update] or press <F4> to save.

ODBC

This tab allows you to manage an ODBC (third-party database).
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Connection

Enable ODBC Check the box to enable an ODBC connection.

ODBC data
connection

definition

In these fields, you can enter the connection name, schema name, and 
ODBC table name. The connection name is the name that was created 
using the FireDac administrator utility to connect to the ODBC data-source 
name. The schema name is the schema definition associated with the 
database and may be needed to access certain database tables. If 
included, the schema name should include the “.” at the end of the name.

Password
encryption

Check box to enable the use of encrypted ODBC database definition. 
Enter password in the text box below for encrypting database, then click 
[Save].

Start FireDac
Administrator

Click to launch the FireDac Administrator. For more information on FireDac 
Utility, see Appendix C “Firedac administrator” on page 167.

Test/Open ODBC
connection

Click to open and test the ODBC connection.

ODBC database
table merge

options

The available options are append only, update only, or append/update. 
When Append only is selected, existing items will not be updated and only 
new items will be added. If Update only is selected, then the existing items 
will be updated, and new items will not be added. If Append/Update is 
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selected, then the existing items will be updated and new items will be 
added.

Field Mapping

This tab allows you to map the field of the ODBC database to the Qbit-DB 
fields.

Figure 39
ODBC Connection tab
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Load table fields Click the [Load table fields] button to view the ODBC fields. In the second 
column, you can use the dropdown arrow on each line to select an 
available Qbit-DB field to which it should map.

Clear all This button clears all fields.

Database
time/date format

This field allows you to format the way in which you’d like the database 
time/date format displayed. Leave this field blank to use the default based 
upon your computer regional settings.

Figure 40
ODBC Field Mapping tab
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Maintenance

Database

Enable
maintenance

Enabling maintenance allows the database to automatically remove 
records older than a certain number of days indicated by the user. This 
function only removes records from the Qbit database. It does not remove 
records from a connected database.

Number of days
to retain records

Enter a number of days to keep the records before they are deleted.

Create text file
backup of deleted

records

Selecting this option will store all deleted records into a file within the 
“Backup” folder located in the installation directory. The text file backup 
name will be the same as the database table name.

NOTE The backup file will need to be manually maintained.

Figure 41
Maintenance tab
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Scale

This is where you can configure weighing options.

Weight trigger

Enable weight trigger

When this box is checked, an automatic measurement occurs after a 
“number of valid samples” have been received from the scale. You can set 
the parameters for valid samples in the fields under Trigger parameters.

Trigger parameters

Valid samples are consistent weights for a certain amount of time. In these 
fields you can set the weights, amount of time, and consistency.

Start tolerance
value

This value indicates at which weight the software will start sensing an 
automatic measurement.

Figure 42
Scale weight trigger tab
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Allowed tolerance This value indicates the highest value of weight at which the software will 
start sensing an automatic measurement.

Sample rate (ms) This is value, in milliseconds, is the frequency at which the software will 
check for a weight measurement.

Measure delay
(ms)

This value, in milliseconds, is the amount of time between checking for a 
valid weight measurement sample.

Number of valid
samples

This value is the number of samples needed to provide an automatic 
weight measurement.

Return to zero
tolerance

This value is the weight at which the software will recognize the absence of 
weight after a measurement.

Third-party

Enable third-party
scale

Check this box to enable the connection of a third-party scale, as some 
Cubiscans do not have an integrated scale.

Model Select the appropriate model from the dropdown menu.

Communication
ports

Select the appropriate connection method and enter identifying 
information in the fields. When selecting a third-party/serial TCP scale, all 
parameters will need to be entered. When selecting a Fairbanks Ultegra™ 

Figure 43
Scale third-party tab



Configuration Scale

Qbit-DB 88

USB scale, the parameters are already defined. When selecting a network 
port, the first column of parameters does not need to be adjusted.

Communication
Parameters

Baud rate: Set baud rate to match baud rate setting on scale.

Parity: Set parity to match parity setting on scale.

Word length: Set word length to match word length setting on scale.

Stop bits: Set stop bits to match stop bits settings on scale.

Start string: The packet will start when the start string has been received. If 
start string is left blank then any character will start the packet. Use the # 
character with a decimal value to set the start string as a control character. 
For example #2 = STX, #13#10 = CRLF

End String/Packet Size: The complete packet has been received when end 
string has been received -or- packet size characters are received. One of 
these parameters must be set. Setting the Packet size to zero will cause 
only the end string to be used. Use the # character with a decimal value to 
set the End string as a control character. For example #3 = ETX, #13#10 = 
CRLF

Weight start position: Set the start position of the weight value.

Weight end position: Set the end position of the weight value.

UOM start position: Set the start position of the unit of measure string. A 
value of zero will ignore any unit of measure.

UOM end position: Set the end position of the unit of measure string.

Include Start/End Strings: Include start and end string in the returned 
packet.

Valid weights separated by zero weight: This will ignore the status/return 
to zero data packet that is sent automatically from the scale.

Request string: Enter the character(s) to make a request for weight from 
the scale indicator. Use the # character with a decimal value to set the 
request string as a control character. For example #2 = STX, #13#10 = CRLF

Example for a Weightronix™ 1310 indicator use W#13.

Scale mode Select either request mode or broadcast mode. In request mode, the scale 
data is transmitted by request. In broadcast mode, the scale data is 
transmitted automatically.
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QR Code

The QR Code feature enables you to create a QR code for each measured 
item. The QR code contains embedded data associated with the measured 
item.

QR code format

This tab is where you can format the data which is contained in the QR 
code.

Enable QR code Checking this box will display a QR code window on the main Qbit-DB 
window.

QR code field
type

Select either delimited or fixed length.

QR code field
delimiter

If you have selected the delimited option under QR code field type, select 
which type of delimiter should separate the fields. The options are comma, 
tab, or other.

Figure 44
QR code format tab
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Other delimiter In this field you can enter a delimiter to separate your data which is 
displayed upon scanning the QR code. For example, you can enter a 
period or a semicolon.

Add double
quotation marks

around character
strings

Checking this box will format the data with double quotation marks around 
character strings.

QR code content

This tab is where you can select the content which is contained in the QR 
code. Table field names will reflect the localized values instead of the actual 
table field name. This is true as well for the import and export mappings.

Click [Load Defaults] if you want to include all table fields in the database 
as it appears in Qbit-DB, or to display all of the fields in the database table 
so that you can edit the layout.

Click [Clear All] to clear all of the fields from the layout list.

Select a table field and then click [Remove] to remove the field from the 
QR code content.

Select a table field and then click [Insert] to insert a field above the 
selected field.

Figure 45
QR code content tab
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Select a table field and then click [Move Up] to move the selected field up 
one position in the table.

Select a table field and then click [Move Down] to move the selected field 
down one position in the table.

Click the drop-down arrow at a table field to display a list of available fields 
and select a field name to add or change a field.

NOTE
The “SPACE FILLER” option in the drop-down list can be used to specify 
an empty or blank field.

If you specified fixed length as the file type in the QR code format tab, click 
in the second column next to a field to change the starting position (in 
number of characters) of the field.

If you specified fixed length as the file type in the QR code format tab, click 
in the Size column next to a field to change the number of characters in the 
field.

Click in the Decimals column for a field to add or change the number of 
characters after the decimal point for entries in the field. This applies to 
decimal fields only (e.g., dimensions, weight, and volume).
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Web services

Qbit-DB web services only supports JSON representations.

JSON requests support two formats: standard and customized.

The standard format is fixed elements, and all elements are sent with every 
request.

The customized format allows the JSON elements to be configured using 
control tags within a text file that is loaded into Qbit-DB.

Endpoint

Check box to enable options for host server.

Figure 46
Endpoint configuration tab
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Configuration 

Host server parameters

URL + Resource Enter the server endpoint here. The server endpoint should include non 
default port numbers as well as proper URL parameters (e.g., 
http://127.0.0.1/SomeResource?ContentType=json).

HTTPS/SSL Click this box to use an HTTPS encrypted connection.

Basic
authentication

Click this box to enable the server to expect a username and password 
validation. Username and password are set within the Credentials tab.

POST as
formatted JSON

text

When enabled, it will send formatted JSON to the server. When 
unchecked, it will send RAW JSON text.

Log JSON
payload

Enable Log JSON payload to store the JSON payload to the log file.

Warning: Storing the JSON payload to the log file will expose any sensitive 
information that is part of the payload such as usernames or passwords. 
Consult with database administrator before enabling this options.

Display errors in a
pop up window

Enabling this will display a pop-up message window if errors occur during 
web service process.

Bypass non 200
response code

exceptions

Enabling this option will override “non 200 response code exception” 
errors to allow response body to be sent as a response.

Include access
token with

request

When selected, this option will include the acquired token as part of the 
JSON request.

Request content
type

Used to indicate the original media type of the resource.

Request accept The Accept request HTTP header indicates which content types, expressed 
as MIME types, the client is able to understand.

Request accept
encoding

The Accept-Encoding request HTTP header indicates the content 
encoding (usually a compression) algorithm) that the client can understand.
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Body parameters Misc body parameters "key=value" can be added as needed as separated 
by "&" character.

Note: When using x-www-form-urlencoded to send the payload use 
key=#Payload to replace #Payload with the actual payload data when 
posting to the endpoint.

Header Key(s) and
Name(s)

Pipe "|" delimited values can be entered to add additional header 
parameters.

Use #key to replace that header value phrase with the encrypted key stored 
from the "Token Endpoint Credentials" tab.

Use #apikey to replace that header value phrase with the encrypted key 
stored from the "Endpoint Credentials" tab "Authorization API Key" text 
box.

For more information and examples see "JSON web serivce.pdf" found in 
the root folder directory.

Credentials

Username and
Password

These fields are used to set the service account credentials for the web 
service interface. Once those credentials have been saved, they will no 
longer be accessible. To add/change the credentials they must be entered 
and saved again.

Authorization API
key

For authorizaiton type “API Key”, enter the key value in the text box. To use 
encrypted api key value in the web service request enter the key name 
“apikey” for header values and enter “#apikey” for the key value on the 
Configuration tab.

Once those credentials have been saved, they will no long be accessible. 
To add or changed the credentials, they must be entered again and saved.

Description

This tab has short explanations for the features on the Endpoint > 
Configuration tab.
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Token Endpoint

Check box to enable token endpoint options for host server. Note that this 
is only supported for OAuth 2.0 Bearer tokens.

Configuration

Type Select either basic or client secret. 

Client Secret: With this option the needed parameter(s) must be entered 
into the "Body Parameters" text box located on the token credentials tab.

"Body Parameters" name = value must be separated by "&" character.

Basic: With this option the private key must be entered into the "Private 
key" text box located on the token credentials tab.

"Private key" private key value must be prefixed with "Basic" if required by 
the server.

URL+ Resource The server endpoint could include non-default port numbers as well as 
proper url params. e.g. http://127.0.0.1/SomeResource?ContentType=json

Figure 47
Token Endpoint configuration tab



Configuration Web services

Qbit-DB 96

Basic
Authentication

Enabled for the server expecting a username and password validation.

Username and password are set within the token "Credentials" tab.

Log JSON
payload

When enabled it will save the JSON request information to the log file.

Be away that enabling this option will expose any sensitive information that 
is part of the payload such as usernames or passwords.

Display errors in a
pop-up window

Will display a pop-up message window if errors occur during web service 
process.

Bypass non 200
response code

exceptions

Override non 200 response code exceptions errors to allow response body 
to be sent as a response.

Request content
type

Used to indicate the original media type of the resource.

Request accept The Accept request HTTP header indicates which content types, expressed 
as MIME types, the client is able to understand.

Request accept
encoding

The Accept-Encoding request HTTP header indicates the content 
encoding (usually a compression) algorithm that the client can understand.

Grant type and
misc body

parameters

Misc body parameters "key=value" can be added as needed and 
separated by "&" character.

The following #TAGS (#username, #password,#key) can be used as a place 
holder when defining parameters such as:

username=#username&password=#password 

TAG values will be replaced with the encrypted values saved from the 
token credentials tab text boxes.

Send request key
as body

parameter

This will include the private key as a request body parameter. When not 
enabled, the private key is sent as a header key name parameter 
"Authorization".

Credentials

Username and
Password

These fields are used to set the service account credentials for the web 
service interface token retrieval. Once those credentials have been saved, 
they will no longer be accessible. To add/change the credentials they must 
be entered and saved again.
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Key or body parameters must be prefixed with required token types such 
as “Basic” followed by the value or client_id=clientid and seperated by 
“&” character.

Body value parameters can be defined using #username. #password, #key, 
using the encrypted values from the token credentials tab.

Once those credentials have been saved, they will no long be accessible. 
To add or changed the credentials, they must be entered again and saved.

Description

This tab has short explanations for the features on the Token Endpoint > 
Configuration tab.

Bulk Processing

For users who are unable to set up posting due to network concerns, bulk 
processing is provided to allow for a one time transmitting of data. 
Complete the following steps to set up bulk processing:

1. Select bulk mode. Options include Array or Record by record. The first 
option allows for all data to be transmitted as a single JSON array. The 
second transmits data in several packets for each records.

When selecting Array, a text box will appear to enter the name of the 
array.

2. Select which records to transmit. Options include All database records 
or Records by date range. All database records may be transmitted or 
a selection of records according to data range.

3. Click [OK] to keep selections.

To start the bulk processing, select Start bulk web service process from the 
Actions menu. If All database records is selected, bulk processing will 
immediately begin. If Records by date range is selected, a prompt will be 
appear asking for a date range.
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JSON POST Format

Standard JSON Format

Fixed elements and all elements are sent with each request. Each element 
matches a database table field name as shown below.

Example of JSON Standard format request:

JSON Element Name Database Table Field Name
identifier ITEM_ID
packType ITEM_TYPE
description DESCRIPTION
netLength NET_LENGTH
netWidth NET_WIDTH
netHeight NET_HEIGHT
netWeight NET_WEIGHT
netVolume NET_VOLUME
netDimWeight NET_DIM_WGT
dimUnit DIM_UNIT
wgtUnit WGT_UNIT
volUnit VOL_UNIT
factor FACTOR
siteId SITE_ID
timestamp TIME_STAMP
optionalInfo1 OPT_INFO_1
optionalInfo2 OPT_INFO_2
optionalInfo3 OPT_INFO_3
optionalInfo4 OPT_INFO_4
optionalInfo5 OPT_INFO_5
optionalInfo6 OPT_INFO_6
optionalInfo7 OPT_INFO_7
optionalInfo8 OPT_INFO_8
imageFile IMAGE_FILE_NAME
updated UPDATED
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Customizable JSON format

This allows the JSON elements to be configured using a text file that is 
loaded into Qbit-DB. The customizable JSON is manually defined in the 
“JSON custom format.txt” file using control tags to create the desired 
JSON output format. 

Control tag
meanings

#TEXT# - Literal text used for brackets, braces, commas, colons, and static 
object names and values.

#OBJECTNAME# - Defines an object that needs a value from the database 
table using the control tag #TABLEFIELDNAME# or credentials using 
control tags #USERNAME# and #PASSWORD#.

~NUMERIC Defines an object identified by the #OBJECTNAME# as a 
numeric type so the element value will not be encapsulated within double 
quotes. Note: #OBJECTNAME# must precede the ~NUMERIC definition.

^SEPARATOR”x” Overrides the object value identified by the 
#OBJECTNAME# to replace the default numeric separator, with the new 
characters as defined by “x”. (“,” or “.”)_ Note: #OBJECTNAME# must 
precede the ^SEPARATOR definition.
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e.g., #OBJECTNAME# "weightNet": #TABLEFIELDNAME# $NET_WEIGHT 
~SEPARATOR”,”

(changes 3.7 to 3,7)

Note: “@”, “~” and “^” is the required order of the formatting when using 
any combination of these special characters.

Example 1: #OBJECTNAME# "Width": #TABLEFIELDNAME# 
$NET_WIDTH ~NUMERIC ^SEPARATOR","

Example 2: #OBJECTNAME# "Length": #TABLEFIELDNAME# 
$NET_LENGTH @0000.0## ~NUMERIC ^SEPARATOR","

<ESC> Defines a format of JSON within JSON using the escape character 
and must be used in conjunction with the #OBJECTNAME# control tag. 
e.g. #OBJECTNAME# <ESC>"ItemNumber": #TABLEFIELDNAME# 
$ITEM_ID

#TABLEFIELDNAME# - Used in conjunction with the #OBJECTNAME# tag 
to do a lookup for the object name value stored in the database table as 
defined from the #TABLEFIELDNAME# text following the $ character.

$ - Text following this character is the database table field name.

@ - Text following this character is the database table field numeric format 
or date/time stamp format.

#USERNAME# - Control tag used in conjunction with the #OBJECTNAME# 
tag that will be replaced with a username value.

#PASSWORD# - Control tag used in conjunction with the #OBJECTNAME# 
tag that will be replaced with a password value.

NOTE Username and password values are encrypted when stored within 
the Qbit application, and are never exposed as readable text.
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JSON Export formatting resource

Specifier Displays

c Displays the date using the format given by localized settings in Windows.
d Displays the day as a number without a leading zero (1-31).
dd Displays the day as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by the short Windows 

localized global variable.
dddd Displays the day as a full name (Sunday-Saturday) using the strings given by the Windows 

localized global variable.
ddddd Displays the date using the format given by the Windows short localized global variable.
dddddd Displays the date using the format given by the Windows long localized global variable. 
m Displays the month as a number without a leading zero (1-12). If the m specifier 

immediately follows an h or hh specifier, the minute rather than the month is displayed.
mm Displays the month as a number with a leading zero (01-12). If the mm specifier 

immediately follows an h or hh specifier, the minute rather than the month is displayed.
mmm Displays the month as an abbreviation (Jan-Dec) using the strings given by the Windows 

short localized global variable. 
mmmm Displays the month as a full name (January-December) using the strings given by the 

Windows long localized global variable. 
yy Displays the year as a two-digit number (00-99).
yyyy Displays the year as a four-digit number (0000-9999).
h Displays the hour without a leading zero (0-23).
hh Displays the hour with a leading zero (00-23).
n Displays the minute without a leading zero (0-59).
nn Displays the minute with a leading zero (00-59).
s Displays the second without a leading zero (0-59).
ss Displays the second with a leading zero (00-59).
t Displays the time using the format given by localized settings in Windows.
tt Displays the time using the format given by the Windows long localized global variable. 
am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any hour 

before noon, and 'pm' for any hour after noon. The am/pm specifier can use lower, upper, 
or mixed case, and the result is displayed accordingly.

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any hour 
before noon, and 'p' for any hour after noon. The a/p specifier can use lower, upper, or 
mixed case, and the result is displayed accordingly.

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays the contents of 
the “am” for any hour before noon, and the contents of the “pm”  for any hour after noon.

/ Displays the date separator character given by localized settings in Windows.
: Displays the time separator character given by localized settings in Windows.
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Custom JSON format examples:

Example 1:

#TEXT# {

#TEXT# "Payload":[

#TEXT# {

#OBJECTNAME# "itemNumber": #TABLEFIELDNAME# $ITEM_ID

#TEXT# ,

#OBJECTNAME# "weightNet": #TABLEFIELDNAME# $NET_WEIGHT

#TEXT# ,

#TEXT# "unitSize":

#TEXT# {

#OBJECTNAME# "sizeLength": #TABLEFIELDNAME# $NET_LENGTH

#TEXT# ,

#OBJECTNAME# "sizeWidth": #TABLEFIELDNAME# $NET_WIDTH

#TEXT# ,

#OBJECTNAME# "sizeHeight": #TABLEFIELDNAME# $NET_HEIGHT

#TEXT# },

#TEXT# "company":

#TEXT# {

#TEXT# "code":"ABC"

#TEXT# }

#TEXT# }

#TEXT# ]

#TEXT# }

Example 1 formatted JSON output:

{

  "Payload": [

    {

      "itemNumber": "1234",

      "weightNet": "12.3",

      "unitSize": {

        "sizeLength": "5.1",

        "sizeWidth": "6.2",

        "sizeHeight": "7.3"

      },

      "company": {

        "code": "ABC"

      }

    }

  ]
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}

Example 1 actual JSON exported output:

{"Payload":[{"itemNumber":"1234","weightNet":"12.3","unitSize":{"sizeLength":"5.1","si
zeWidth":"6.2","sizeHeight":"7.3"},"company":{"code":"ABC"}}]}

Example 2:

#TEXT# {

#TEXT# "DATA":

#TEXT# {

#OBJECTNAME# "itemNumber": #TABLEFIELDNAME# $ITEM_ID

#TEXT# ,

#OBJECTNAME# "Description": #TABLEFIELDNAME# $DESCRIPTION

#TEXT# ,

#OBJECTNAME# "netLength": #TABLEFIELDNAME# $NET_LENGTH @0000.0##

#TEXT# ,

#OBJECTNAME# "netWidth": #TABLEFIELDNAME# $NET_WIDTH @###0.00#

#TEXT# ,

#OBJECTNAME# "netHeight": #TABLEFIELDNAME# $NET_HEIGHT @###0.000

#TEXT# ,

#OBJECTNAME# "netWeight": #TABLEFIELDNAME# $NET_WEIGHT @###0.0000

#TEXT# ,

#OBJECTNAME# "dimUnit": #TABLEFIELDNAME# $DIM_UNIT

#TEXT# ,

#OBJECTNAME# "wgtUnit": #TABLEFIELDNAME# $WGT_UNIT

#TEXT# ,

#OBJECTNAME# "timeStamp": #TABLEFIELDNAME# $TIME_STAMP @YYYY-MM-DD 

HH:NN:SS

#TEXT# ,

#OBJECTNAME# "userId": #TABLEFIELDNAME# $OPT_INFO_1

#TEXT# ,

#OBJECTNAME# "siteId": #TABLEFIELDNAME# $SITE_ID

#TEXT# ,

#TEXT# "countryCode":"USA"

#TEXT# }

#TEXT# }

Example 2 formatted JSON output:

{

  "DATA": {

    "itemNumber": "123",

    "Description": "test item 123",

    "netLength": "0005.5",
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    "netWidth": "6.60",

    "netHeight": "7.700",

    "netWeight": "11.2000",

    "dimUnit": "in",

    "wgtUnit": "lb",

    "timeStamp": "2021-07-20 09:34:44",

    "userId": "JT",

    "siteId": "PHX",

    "countryCode": "USA"

  }

}

Example 2 actual JSON exported output for text file:

{"DATA":{"itemNumber":"123","Description":"test item 

123","netLength":"0005.5","netWidth":"6.60","netHeight":"7.700","netWeight":"11.200

0","dimUnit":"in","wgtUnit":"lb","timeStamp":"2021-07-20 

09:34:44","userId":"JT","siteId":"PHX","countryCode":"USA"}}

Example 3:

#TEXT# {

#TEXT# "settings":

#TEXT# {

#OBJECTNAME# "jsonUser": #USERNAME#

#TEXT# ,

#OBJECTNAME# "jsonPassword": #PASSWORD#

#TEXT# ,

#TEXT# "programName":"Qbit-DB"

#TEXT# },

#TEXT# "cubiscan": 

#TEXT# {

#OBJECTNAME# "itemNumber": #TABLEFIELDNAME# $ITEM_ID

#TEXT# ,

#OBJECTNAME# "Description": #TABLEFIELDNAME# $DESCRIPTION

#TEXT# ,

#OBJECTNAME# "netLength": #TABLEFIELDNAME# $NET_LENGTH @0000.0##

#TEXT# ,

#OBJECTNAME# "netWidth": #TABLEFIELDNAME# $NET_WIDTH @###0.00#

#TEXT# ,

#OBJECTNAME# "netHeight": #TABLEFIELDNAME# $NET_HEIGHT @###0.000

#TEXT# ,

#OBJECTNAME# "netWeight": #TABLEFIELDNAME# $NET_WEIGHT @###0.0000

#TEXT# ,

#OBJECTNAME# "dimUnit": #TABLEFIELDNAME# $DIM_UNIT
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#TEXT# ,

#OBJECTNAME# "wgtUnit": #TABLEFIELDNAME# $WGT_UNIT

#TEXT# ,

#OBJECTNAME# "timeStamp": #TABLEFIELDNAME# $TIME_STAMP @YYYY-MM-DD 

HH:NN:SS

#TEXT# ,

#OBJECTNAME# "qty": #TABLEFIELDNAME# $OPT_INFO_1

#TEXT# ,

#OBJECTNAME# "siteId": #TABLEFIELDNAME# $SITE_ID

#TEXT# }

#TEXT# }

Example 3 formatted JSON output:

{

  "settings": {

    "jsonUser": "xyz123",

    "jsonPassword": "abc123",

    "programName": "Qbit-DB"

  },

  "cubiscan": {

    "itemNumber": "123",

    "Description": "test item 123",

    "netLength": "0005.5",

    "netWidth": "6.60",

    "netHeight": "7.700",

    "netWeight": "11.2000",

    "dimUnit": "in",

    "wgtUnit": "lb",

    "timeStamp": "2021-07-20 09:34:44",

    "qty": "1",

    "siteId": "PHX"

  }

}

Example 3 actual JSON exported output for text file:

{"settings":{"jsonUser":"xyz123","jsonPassword":"abc123","programName":"Qbit-DB"},"
cubiscan":{"itemNumber":"123","Description":"test item 
123","netLength":"0005.5","netWidth":"6.60","netHeight":"7.700","netWeight":"11.200
0","dimUnit":"in","wgtUnit":"lb","timeStamp":"2021-07-20 
09:34:44","qty":"1","siteId":"PHX"}}
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Error records

When posting and transmitting data, failed attempts are stored as text files 
in the Webservice repository folder. To view and access these error files, 
select the menu Actions > Web service errors which will open the dialog 
below.

Refresh Clicking this button will show all existing error files.

Transfer Clicking this button will attempt to re-transmit the select error file to the 
web server and if successful will delete the error file from the list.

Delete all files Clicking this button will delete all error files.

Exit Clicking this button will close the dialog.

Figure 48
Web service errors dialog
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Custom Payload 2

A second custom payload format different from the first may be created 
and assigned to be sent dependent on the value in a select option field.

To set up a second custom payload complete the following steps:

1. Click in the box for Enable JSON custom format 2 payload to enable 
the option.

2. Select the Reference field form the drop down options.

3. Enter the reference values to which the secondary format will be 
assigned in the text box below Reference value(s).

4. Click [OK] to save settings.

5. A second JSON custom format file will appear in the root folder named 
JSON custom format2.txt. Edit this file according to your desired 
formatting needs. For formatting instructions, see  “Customizable 
JSON format” on page 99.

Figure 49
Custom Payload2
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Proxy Server

To setup a proxy server for posting and other transmissions select the proxy 
tab under Webservices. Click in the check box to enable the proxy server 
option.

Proxy server Enter the address of the proxy server.

Proxy port Enter the port of the proxy server.

Web credentials The Username and Password fields are only used to set the service account 
credentials for the web service proxy server. Once the credentials are 
saved, they are no longer accessible. To add or change the credentials, 
they must be entered and saved again.

Figure 50
Proxy server
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CHAPTER 3
DATABASE MANAGEMENT

Item measurements and weights are stored in item records (by item 
number) in a Qbit-DB database table (Access database). This chapter 
provides information and instructions on managing your Qbit-DB 
databases. Most of the database functions are found on the Database 
menu. The Import and Export functions are on the File menu.

NOTE
Depending on your database, some functions may not be available. If you 
have questions about making certain functions available, consult with your 
database administrator to ensure that your database will allow your desired 
functionality. Custom scripts can be created to provide greater functionality 
for customer defined databases (see Appendix C “Firedac administrator” 
on page 167).

When you start Qbit-DB for the first time, an empty database is opened 
with the default name “Cubiscan”. All of the measurements and weights of 
the objects you measure are recorded and saved in the open database. 
You can do either of the following:

• Record the information in the “Cubiscan” database table.

• Create a new database table using the New table function (see “Cre-
ating a new database” on page 109).

If you already have a Qbit-DB database or databases, the last database 
loaded is opened when you start Qbit-DB. You can do any of the following:

• Save new measurements and weights in the open database table.

• Open a different database table using the Open table function (see 
“Opening a database” on page 110).

• Create a new database table using the New table function (see “Cre-
ating a new database” on page 109).

Creating a new database

Do the following to create a new database.
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1. Pull down the Database menu and select New table, and the following 
prompt is displayed.

2. Type the name that you want to give the new database table.

NOTE
If you enter the name of an existing database table, an error message 
appears warning you that the database already exists.

3. Click [OK] and the new, empty database table is opened so you can 
begin entering data into it.

Opening a database

Do the following to open an existing database.

1. Select Open table from the Database menu, and the following dialog 
box is displayed.

All of the database tables in Qbit-DB are listed.
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2. Click the name of the database table that you want to open, and the 
table is loaded into Qbit-DB.

Click [Cancel] if you do not want to open a new table.

Deleting a database

Do the following to delete a database table.

1. Select Delete table from the Database menu, and the following dialog 
box is displayed.

All of the database tables in Qbit-DB are listed.

2. Click the name of the database table that you want to delete, and the 
following warning is displayed.

3. All records in the selected database table will be deleted and cannot 
be recovered. Click [Yes] if you want to delete the specified database 
table.
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The following message is displayed.

4. Click [OK] to close the message.

NOTE
You cannot delete a database that is currently open. Either create a new 
database or open another existing database so that you will be allowed to 
delete the correct database.

Emptying a database

Do the following to delete all of the records from a database table.

1. Make sure the table from which you want to delete all records is the 
open table.

2. Select Empty table from the Database menu, and the following prompt 
is displayed.

3. All records in the open database table will be deleted and cannot be 
recovered. Click [Yes] if you want to empty the database table.

The following message is displayed.



Database Management Copying a database

Qbit-DB 113

4. Click [OK] to close the message.

Copying a database

You can save a copy of a database table to use as a backup in case of 
problems with the database or a hard disk or other computer failure. 

Making a backup of your database table is highly recommended. Ask your 
IT administrator how often a backup should be created.

NOTE
Backing up your database only works when using the default database MS 
Access.

Do the following to save a copy of the database (the original database 
remains unchanged).

1. Select Save copy as from the Database menu, and a Save As dialog 
box is displayed. 

2. To save the copy to a drive or folder, select the drive letter and/or 
folder at the Save in box.

3. Type a name for the duplicate database in the File name field. The 
“.mdb” file extension is added automatically.

4. Click [Save] to save the duplicate database. The original database 
remains available in Qbit-DB. The database that was open when you 
performed the copy function remains open.

You should save backups on removable media (e.g., thumb drive, tape, 
Zip disk, etc.) and store them in a secure place so that they are available 
in the event of a hard disk or other computer failure.

Importing to a database table

Use the Import function on the File menu to import data from an external 
ASCII text file source or cvs file. You must set up the import file options 
before importing a file. Also, the layout of the information in the text file 
must match the Qbit-DB database layout to be imported correctly. 
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Do the following to configure import data options.

1. Open the database table to which you want to add or update the new 
data (see “Opening a database” on page 110).

If you want to create a new database table with the imported data, cre-
ate a new, empty database table with a unique name in which you will 
insert the imported data (see “Creating a new database” on page 109).

2. Pull down the Tools menu, and select Options.

3. Click the Import tab and then the Import type tab.

4. Select the method you want to use to import the data into the existing 
database.

Append only
Only new items are added to the existing database. Duplicate items 
(items with the same item numbers) are not added or updated.

Update only
Duplicate items are updated, but new items are not added to the data-
base.

Append/Update
New items are added to the existing database, and any duplicate items 
are updated.

NOTE
If you are importing data into a new, empty database, select either Append 
only or Append/Update. (Because you are adding the data to an empty 
database table, there can be no duplicate records.)

5. If you have not already done so, select the other import options, and 
map the import file fields to the database fields in the Import layout 
tab.

6. Click [OK] to save and close the Options dialog box.

NOTE
You may want to back up the existing database table before importing a 
file into it. Refer to “Copying a database” on page 113 for information.

Click Import on the File menu, and a submenu is displayed with the 
following functions:

Run auto import
Select this function to start the automatic import that you have already set 
up.
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Run manual import
Complete the following steps to run a manual import.

1. Select Import > Run manual import from the File menu.

2. If necessary, navigate to the file location and select the file you want to 
import.

3. If necessary, select the format of the imported file (e.g., .xls).

4. Click the name of the text file to import, and it is inserted in the File 
name field.

5. Click [Open] to import the file into the open database table.

The status of the import process and any errors encountered are displayed 
in the message box. 

Exporting a database table

Use the Export option to export an entire Qbit-DB database table or a 
portion of a database table to a variable or fixed length format ASCII text 
file. You can also use “auto export” to upload the database via FTP. You 
must set up the export file options before exporting data (see “Export 
type” on page 37). You can also change the layout of the Qbit-DB 
database table to be exported. Refer to “Export layout” on page 41 for 
instructions.

To export to an ODBC data source, see “This tab allows you to manage an 
ODBC (third-party database).” on page 81.

Select Export on the File menu, and a submenu is displayed with the 
following functions:

Run auto export
Select this function to start the automatic export that you have already set 
up. (See “Auto export” on page 44.)

Run manual export
When you click this function, a submenu is displayed with the following 
options: 

All data: Select this option to create a text file that contains all 
records in the current database.
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Updated data: Select this option to create a text file that contains 
only records updated or added since the last export.

Date range: Select this option to create a text file containing all 
records updated or added within a specified period of time.

Run auto export

You can use the Run auto export function to start the automatic export that 
you have set up. The export will take place immediately using the options 
that you set up in the Auto export tab in Options (refer to “Auto export” 
on page 44).

This function is useful if you want to manually upload the database to a 
network using FTP. Set up auto export by selecting the Activate FTP 
upload option and entering the required login and mode information. 
Then select Run auto export to upload the data immediately.

Run manual export

Select this function if you want to manually export all or part of the 
database to a text file. Select one of the following options.

All data/
updated data

Select the All data option to create an export text file containing all records 
in the current database, or select the Updated data option to create an 
export file containing only records updated or added since the last export. 
An updated record is indicated by a “Y” (Yes) in the Updated (last) column 
in the database table. After a record has been exported, an “N” (No) is 
shown in the Updated column.

Take the following steps to export data using either the All data or 
Updated data option.

1. Pull down the Tools menu, and select Options.

2. Select the Export tab and then the Export type tab.

3. Select the export file type and other applicable options (see “Export 
type” on page 37).

4. If you want to change the layout of the data, select the Export layout 
tab and make the desired changes (see “Export layout” on page 41).

5. Click [OK] to save and close the Options dialog box.

6. Select All data or Updated data from the Run manual export submenu.
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7. Navigate to your preferred file location.

8. Enter a name for the export file in the File name field, including the 
extension, which can be any ASCII text file extension (e.g., .txt, .csv).

If you want to copy over an existing export file, select the drive/folder 
containing the file you want to copy over, and click the file name to 
insert it in the File name field.

9. Click [Save] to export the database table to the file.

The status of the export and any errors are displayed in the message box.

Date range Use the Date range option to save an export text file containing all records 
that were updated or added within a specified period of time.

1. Select Date range from the Run manual export submenu, and the 
following dialog box is displayed.

2. By default, the “From” date is yesterday’s date, and the “To” date is 

today’s date. To change a date, click  and a calendar is displayed 
from which to choose the date, as follows.

3. Select the date, and click [OK]. The date is inserted in the From date or 
To date field.
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The export file will contain all records added or updated on and 
between the dates you selected.

4. Click [OK] to export the data to the file.

The status of the export and any errors are displayed in the message box.
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CHAPTER 4
CUBISCAN FUNCTIONS

This chapter provides information on the Qbit-DB functions used to verify, 
reset, and test the Cubiscan. These functions are selected from the Tools 
menu and include the following:

• Zero
Use this function to zero the Cubiscan weight and dims values.

• Status
Use this function to verify that the Cubiscan is operating properly.

• Test mode
Use this function to set up the Cubiscan for testing.

• Values
Use this function to display a table of sensor values that can be useful 
for troubleshooting problems.

NOTE
The Zero, Status, Test mode, Values, and Calibrate functions may not be available 
(if not available, they are dimmed or grayed) depending on whether or not the 
functions are available on the selected Cubiscan model.

Refer to the following sections for more information on each function.

Zero

Use the Zero function to “zero” the Cubiscan. Zeroing sets all dims and 
weight to zero. The weight of the platform and the measurement from each 
sensor to the platform sides when the platform is empty must be set to 
zero for the Cubiscan to operate properly. A Cubiscan zeros itself 
automatically every five seconds when it is not in Measure mode. However, 
you may need to manually zero the Cubiscan in the following 
circumstances:

• If during a long measuring session environmental conditions (tem-
perature and humidity) have changed noticeably.

• If you suspect that the last zeroing was in error (e.g., something was 
on the platform).
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NOTE
Make certain that the Cubiscan platform is free of all objects before zeroing. If not, 
the zero reading will not be accurate.

1. Pull down the Tools menu and select Zero. The following prompt is 
displayed.

2. Verify that the Cubiscan platform is free of ALL objects, then click [OK] 
to proceed.

3. After the scale and sensors are zeroed, the following message is 
displayed. 

4. Click [OK] to return to the main window.

Status

Use the Status function to verify that the Cubiscan is operating properly.

1. Select Status from the Tools menu, and the following prompt is 
displayed.

2. Verify that the Cubiscan platform is free of ALL objects, then click [OK] 
to proceed.
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3. The current status is checked and an appropriate message returned. If 
there are no problems, the following message is displayed. 

4. Click [OK] to return to the main window.

If any problems are found, an error message appears. For example:

TAXX – [error message]

(where XX is the error number)

If you get an error message, first verify that the Cubiscan is turned on, 
then refer to the Troubleshooting chapter in your Cubiscan manual for 
further help.
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Test mode

Use the Test mode function to set up the Cubiscan for testing purposes. 
When you select this function, the Cubiscan measures, weighs, and 
displays the results continuously, as shown below.

The collected data continues to scroll on the screen until you exit test 
mode. The data collected is not recorded or saved. To exit from Test mode, 
click [Cancel].

Figure 51
Test mode
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Values

Use the Values function to display a table of sensor values that can be 
useful for troubleshooting problems with the Cubiscan.

Click [OK] to return to the main window.

Barcode.ini

For those Cubiscan models that use the serial barcode, some additional 
paring options are available. To take advantage of these options, the 
barcode.ini file will need be accessed from the root folder.

Parsing will be based on three different default criteria: start position, 
length, and unique identifier. Use these criteria to assign special parsing 
operation to get information when scanning a barcode. 

1. Complete the following steps to setup parsing with the barcode 
scanner:

2. Locate the barcode.ini file in the root folder.

Figure 52
Cubiscan values
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3. Open the .ini file with a basic text editor like notepad. 

4. Scroll down to //BARCODE FIELD and enter the parsing constructions 
next to the respective criteria. 

For example, when a unique identifier such as a hash tag is scanned by the 
barcode, the instructions will let tell Qbit-DB what to do with the 
information. It may grab the next five letters in the string or add a prefix to 
the data received. 

5. Be sure to save file and reload Qbit DB before taking any further 
measurements.

For more information on how to set up the parsing, contact Cubiscan 
support.

Figure 53
Barcode.ini
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CHAPTER 5
MEASURING OBJECTS

This chapter describes how to measure objects. If your Cubiscan has a 
scale, weight is automatically recorded at the same time as the 
measurements.

There are two methods you can use to measure objects in Qbit-DB 
depending on how you enter items in your database, as follows.

1. Measure items that are already listed in an imported database (refer to 
“Importing to a database table” on page 113 for information on 
importing a database). Depending on your setup, there are two ways to 
select the item to be measured from the database.

Auto advance:
If you will be measuring items in the same order they are listed in the 
database, you can set up the Auto advance through items function in 
Options (see “Database” on page 20 for information). If Auto advance 
is set up, you select the first item, and Qbit-DB automatically moves 
down the database list in sequential order as you measure and update 
each item. However, you can also manually click an item to select it.

Select items manually:
Click the item in the database table to select the item, as shown below.

2. Enter items manually or by scanning as you measure each item.

With the cursor at the Item number field, you can do one of the follow-
ing:

• If your system has a scanner, scan the item and the number is 
inserted in the Item number field. Then press <Enter>.

• Type the item number in the Item number field, and press <Enter>.

NOTE
An <Enter> key can be programmed into a barcode scanner; see your system or 
hardware administrator for assistance.
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Measuring existing items

Do the following to measure items listed in an existing database.

1. If necessary, open the database that contains the items you are going 
to measure.

2. Verify that all of the Cubiscan options have been set up correctly (see 
“Cubiscan” on page 18).

3. Place the item to be measured on the Cubiscan (refer to your Cubiscan 
Operations Manual for details on correct object placement).

4. In Qbit-DB, select the item to be measured using one of the methods 
described at the beginning of this section.

5. Click  to measure the item. The measurement process is shown 
on the screen, the measurements are inserted into the dimension 
fields, and a simulation of the measured object is shown in the 
Cubiscan picture box.

6. (This step is only necessary if “tare” is enabled and the object being 
measured requires a tare adjustment.) To apply tare values to an item, 
pull down the Actions menu and select Apply tare values or press 
<Ctrl><T> after you measure the item. Tare values are subtracted from 
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the measurements or weight. (Set up tare values in Options on the 
Tools menu. Refer to “Tare values” on page 24 for information.)

7. Edit the data as required (see “Editing data” on page 131).

8. When you are finished, click  to update the item record.

To clear an item’s measurement data and start over (or to measure a dif-

ferent item), click . A record must either be updated or cleared 

before you can measure another item.

9. Remove the item from the Cubiscan, and repeat the steps above for 
the next item.

Measuring new items

Do the following to enter new items into the database as you measure 
them.

1. If necessary, open the database in which you want to enter the items 
you are measuring.

2. Verify that all of the Cubiscan options have been set up correctly (see 
“Cubiscan” on page 18).

3. Place the item to be measured on the Cubiscan (refer to your Cubiscan 
Operations Manual for details on correct object placement).

4. Verify that the cursor is in the Item number field.

If not, click  to save the last measurement or click  if it is 

not valid or is already saved.

5. Scan the item or type in the item number, and press <Enter>. An 
<Enter> key can be programmed into a barcode scanner; see your 
system or hardware administrator for help.

6. Click  to measure the item. The measurement process is shown 
on the screen, the measurements are inserted into the dimension 



Measuring Objects Measuring new items

Qbit-DB 128

fields, and a simulation of the measured object is shown in the 
Cubiscan picture box.

7. (This step is only necessary if “tare” is enabled and the object being 
measured requires a tare adjustment.) To apply tare values to an item, 
pull down the Actions menu and select Apply tare values, or press 
<Ctrl><T> after you measure the item. Tare values are subtracted from 
the measurements or weight. (Set up tare values in Options on the 
Tools menu. Refer to “Tare values” on page 24 for information.)

8. Edit the data as required (see “Editing data” on page 131).

9. When you are finished, click  to update the item record.

To clear an item’s measurement data and start over (or to measure a dif-

ferent item), click . A record must either be updated or cleared 

before you can measure another item.

10. Remove the item from the Cubiscan, and repeat the steps above for 
the next item.
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Measuring items with cross 
reference lookup enabled

Do the following to measure items using the Cross reference lookup 
functionality. This function may be used with a barcode scanner. (If using a 
barcode scanner, it may be helpful to program your scanner with an 
automatic carriage return feed.)

NOTE
When using a barcode scanner, you must have Windows focus on Qbit-DB for the 
barcode information to be fed into the program.

1. Open Qbit-DB and enable the Enable cross-reference lookup withing 
optional info fields located under Tools > Options > Database. Click 
[OK] when you are finished.

2. When you exit the Tools > Options window, the following window 
appears. 

3. Select from the Select search column drop-down list. Alternatively, you 
may also click [Repeat item number] or press F9 on the keyboard to 
load the last scanned item.

4. Scan or enter the search value in the Search field. You may also search 
using only a few starting characters in the value by checking the box 
next to Include records that start with search value.

Qbit-DB will find the information that is associated with the selected 
search field (e.g., Item number, UPC, etc.) according to the information 
that you entered in the Search field.
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5. A Select record window will appear with all items that match the search 
criteria. Choose which item to lookup.

6. The information for the chosen item will populate in the main window.

Measuring stacked quantities

If you want to stack like items for measurement but want the dimensions for 
each item included separately in the database, use the Stacked quantities 
box.

1. If the Stacked quantities box is not visible, pull down the View menu, 
and select Stacking.

2. Place the stack of objects on the Cubiscan platform. Make sure all the 
edges of the objects are aligned.

3. Identify and measure the stacked objects, and enter the quantity in the 
Stacked quantities box in the Height, Length, and Width fields as 
applicable.

4. Measure the item by clicking the Measure button, <F3>, or using the 
measuring gate.

The Cubiscan values will be calculated using the stack quantity values 
and the division result will be stored to the database.
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Editing data

At any time after measuring an item, you can edit any of its measurements 
using one of the following methods. Click the item in the database table to 
select it.

Edit Fields You can edit any field that is not grayed (has a white background).

Click in a field to edit it, and type over the existing entry. Then click  
to update the information in the database.

Swap
Measurements

You can change the orientation of an item using one of the “swap” 
functions. Pull down the Actions menu and select a function (or use the 
specified keyboard shortcut), as follows:

• Select Swap length for width (or press <Ctrl><L>) to switch the 
length and width measurement values for the selected item.

• Select Swap width for height (or press <Ctrl><W>) to switch the 
width and height measurement values for the selected item.

• Select Swap height for length (or press <Ctrl><H>) to switch the 
height and length measurement values for the selected item. 

When you have finished, click  to update the information in the 
database.
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CHAPTER 6
REPORTS

The Reports menu contains one standard report. This menu also contains 
the option to generate and design labels that can be viewed or printed by 
the user. 

• The standard report option is a Detail report, explained below.

• For information on creating a label report, see “Label report” on 
page 132.

• For information on designing a label, see “” on page 136.

Detail report

The Detail report lists all recorded data for the open database. Pull down 
the Report menu and select Detail to generate the Detail report. An 
example of the report is shown in Figure 54 on page 133.

The Detail report contains all of the database detail (as shown in the 
database table). If you use user-defined fields, they are included on 
additional lines.

NOTE
You can also generate reports on your measurement data by exporting it 
from Qbit-DB in a text file and importing it into another application, such 
as a word processing or spreadsheet program. Refer to “Exporting a data-
base table” on page 115 and “Importing to a database table” on page 113 
for information.

Label report

The Label report lists the information for the item number that was 
selected when the Reports > Label option was selected.
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The default label displays the item number, barcode, measurement 
dimensions, date, and time. An example is shown in Figure 55 on 
page 134.

To create a label report, the option Enable label report printing must be 
enabled under the Tools > Options > Reports tab.

Report preview

When you select Detail or Label from the Report menu, it is displayed in 
the Preview window, as shown below.

Figure 54
Detail report preview
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In this report view the cursor becomes a hand when it hovers over the 
report. You can use this hand to navigate throughout the report. You can 
also scroll through pages using your mouse or the scroll bars located on 
the right side of the screen. 

Use the buttons on the toolbar to view or print the report, as follows:

Click to print the report. A standard Windows print dialog box is displayed. 
Select a printer, the number of copies you want to print, the pages you 
want to print, and click [OK] to print the report.

Figure 55
Label report preview
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Click to open a different report. A Load report dialog box is displayed. 
Reports are saved in the ... > Cubiscan > Reports folder with an .fp3 
extension by default. If you saved your reports in a different folder, select 
the folder. Select the report you want, and click [Open] to display it.

Click to save the displayed report. A Save Report dialog box is displayed. 
Reports are saved in the ... > Cubiscan > Reports folder with an .fp3 
extension by default. If you want to save your reports in a different folder, 
select the folder. Save report files can be opened in the Qbit-DB report 
viewer (see above).

Click to display the Find text dialog window. This window will allow you to 
search the report for specific word(s) by typing the desired word(s) into the 
Text to find: field. You can also enable the options Search from beginning 
or Case sensitive. Search from the beginning option searches the 
document from the beginning and the case sensitive option makes your 
search case sensitive.

Click to zoom in on the report. Each time you click the report is magnified 
by 25%.

Click the drop-down arrow and select a size to display the report, or click in 
the text box and enter a percentage.

Click to zoom out. Each time you click the report is minimized by 25%.

Click to display the report in the full window view. Right-click anywhere on 
the screen and select Full window to return to the default view.

This report outline button is not applicable in the report or label preview.

Click to display a sidebar that contains thumbnails of all the report pages. 
Click this button again to return to the normal display.

Click to set up the report pages for printing. A Page settings dialog box is 
displayed. Select the size, orientation, margins and other options for each 
page of the report, and click [OK].
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The edit page option is grayed out and not applicable in the report or label 
previewer.

Click to go to the first page of the report.

Click to go to the previous page of the report.

The number of the report page that is shown in the window is displayed in 
this text box. You can type a page number and press <Enter> to display 
that page.

Click to go to the next page of the report.

Click to go to the last page of the report.

Click to close the report and return to the Qbit-DB main window.

Data History Viewer

The Data History Viewer allows users to search for information by primary 
field value, typically item number. This information may then be 
downloaded as an on-hand report.

Complete the following steps to open the Data History Viewer and 
download an on-hand report:
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1. Select Data History form the View menu.

2. To search for an item, enter a distinguishing value such as item number 
in the text box under Primary Field. 

All entries with that value will appear in the table below. Information 
about the item will be displayed along the left panel of the viewer. If 
there are any images associated with the item, they will appear in the 
middle panel.

Toggle between different items by highlighting the item in the table 
below. The information and images for that item will appear in the pan-
els above.

Figure 56
Data history
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3. To print out an on-hand report of the item, select On-Hand from the 
Report menu. This will produce a preview of the on-hand report.

4. From the preview menu, you may print or save the report. By clicking 
the respective icons from the menu bar at the top.

Figure 57
On-hand report
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APPENDIX A
INSTALLATION

This appendix provides instructions for installing Qbit-DB, as well as 
instructions for installing a network or digital camera to work with Qbit-DB.

System requirements

Qbit-DB is designed to operate with the following minimum computer 
requirements:

Processor: PC Pentium III processor or better

Memory: 1 GB RAM

Hard Disk: 40 MB disk space available

Display: VGA 1024 x 768 or higher resolution color display (will not operate at a 
lower resolution; e.g., 800 x 600)

Operating
System:

Microsoft® Windows 2000®, Windows XP, 7, 8, 8.1, 10, or 11.

Other: Quantronix Inc. Cubiscan™ unit attached to computer

Installing Qbit-DB

Do the following to install Qbit-DB on your computer.

1. Close any open Windows applications.

2. Insert the flash drive into an open USB port. The following prompt is 
displayed.
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3. Click Open folder to view files.

4. Double-click the Qbit-DB setup file.

5. If you want the installation in a language other than English, select the 
language from the drop-down list. Click [OK] to proceed.

The welcome window is displayed. 

Figure 58
Qbit-DB installation, welcome window
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6. Click [Next] to continue, and the license agreement window is 
displayed.

Figure 59
Qbit-DB installation, license agreement
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7. Read the license agreement, and click the radio button next to I accept 
the license agreement if you agree. Click [Next] to continue, and the 
following window appears.

Figure 60
Qbit-DB Installation, Destination Folder
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8. Accept the default path for the installation of Qbit-DB, or select a 
different drive and/or folder. Click [Next] to continue. The following 
window is displayed.

9. Accept the default Start menu group, or enter a different name. Select 
All users if you want all users to have access to Qbit-DB on this 
computer or Just me if you want only yourself to have access. If you 
select Just me a password is required to open Qbit-DB.

Figure 61
Qbit-DB installation, start menu
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10. Click [Next] to continue, and the following window appears.

11. If you want to review or change any of the settings, click [Back]. If not, 
click [Next] to continue.

Figure 62
Qbit-DB installation, ready to install
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12. When the installation is complete, the following window appears:

13. If you do not want to start Qbit-DB now, click the already checked box 
next to Run Qbit-DB now to remove the checkmark. Click [Finish] to 
exit and close the installation window.

Installing a new version or update of Qbit-DB

If you are installing a new version or update of Qbit-DB (that is older than 
version 02.13.0008 or installed prior to February 2017) complete the 
installation steps listed above. You will then need to complete the 
following steps listed in this section.

Figure 63
Qbit-DB installation, setup complete
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1. Open Qbit-DB.

The following window appears.

2. Select the database that you would like to copy.

3. Click [Transfer data]. (If your current database is not empty you will 
receive an error message. Empty your current database and restart 
Qbit-DB.)

The following message appears.

4. If you have copied all the database information that you want, select 
the Do not display this dialog again option. If you do not select this 
option, the Database Utility window will appear each time you open 
Qbit-DB.

Your old version of Qbit-DB will be automatically deleted when the new 
version is installed.

NOTE
The name of the database that is being imported cannot contain any 
spaces. If the database that you are tying to import does have spaces in the 
name, contact Cubiscan Technical Support at 801.451.0500.

Figure 64
Database Utility window
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Installing a network (Axis) camera

Ensure that you have received all of the correct parts and quantities for the 
Axis network camera kit by referring to the figure below or the parts list on 
page 148.

A USB to Ethernet adapter
B Axis camera
C Tripod
D PoE switch
E Ethernet cables (2)

To install your network camera, complete the following steps.

1. Locate your white TRENDnet USB to Ethernet adapter cable and plug it 
into an available USB port on your computer. Wait for the appropriate 
drivers to load. If there are any problems with this process refer to the 
TRENDnet User’s Guide that came in the box with the adapter.

2. Locate your TRENDnet PoE switch and connect it to a power source.

3. Locate one (of two) of the Ethernet cables and plug one end of the 
cable into the USB to Ethernet adapter cable and the other end into 
the TRENDnet PoE switch. You can plug the Ethernet cable into any of 

Figure 65
Axis camera kit components

E

A
B C D
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the PoE switch ports (1-8), but slots 5-8 are recommended because 
power will not be required.

4. Set up your camera using the tripod (included) or the cart mount 
system (not included) as desired. 

5. Locate the remaining Ethernet cable and plug one end of the cable 
into the PoE Switch. You must plug it into one of the PoE switch ports 
labeled 1-4, or PoE, so that the camera will receive power. Plug the 
other end of the Ethernet cable into the back of the Axis camera. 

A green light should appear at the back of the Axis camera if it has 
been connected correctly. The light will be orange if it has been 
connected incorrectly.

6. To connect the camera with Qbit-DB, see “Images” on page 64.

Parts list for the Axis network camera kit

Following is the parts list for the network camera kit:

Part No. Description Quantity/Unit

13410 PoE switch 1

13411 USB to Ethernet adapter 1

13412 Tripod 1

13413 Ethernet cable, 10 ft 2

13414 Integration camera software (Included with Qbit-DB) 1

13416 Axis camera 1
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Installing a digital camera

Ensure that you have received all of the correct parts and quantities for the 
digital camera kit by referring to the figure below or the parts list on 
page 160.

A Tripod
B USB extension cable
C Digital camera

Your camera may appear different depending on the brand of digital 
camera that you received. 

To install your digital camera, you will need to complete the following 
steps.

1. Install the digital camera software onto your computer. For instructions 
on how to do this, see “Installing the digital camera software” on 
page 150.

2. Load the digital camera driver onto your computer. For instructions on 
how to do this, see “Loading the digital camera driver” on page 154.

Figure 66
Digital camera kit components

A

CB
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3. Connect your camera to Qbit-DB. For instructions on how to do this, 
see “Connecting your camera to Qbit-DB” on page 155.

Installing the digital camera software

NOTE
The following screenshots were taken from a Windows 7 operating system. 
Your screenshots may appear different if you are using a different operating 
system.

To install your digital camera software, complete the following steps:

1. Locate your EOS DIGITAL solution disk that came in the camera box 
and load it into your computer’s CD drive.

The following window will pop up:

2. Select Run SETUP.EXE.
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3. Select the area you live in.

4. Select the country you live in.

Figure 67
Digital camera setup, first screen

Figure 68
Digital camera setup, second screen
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5. Select your language.

6. Select the Custom installation option.

Figure 69
Digital camera setup, third screen

Figure 70
Digital camera installation, fourth screen



Installation Installing a digital camera

Qbit-DB 153

7. Uncheck everything except EOS utility. Click [Next].

8. On the Confirmation screen, make sure that EOS Utility is the only 
software that is going to be installed, then click [Install].

9. Select Yes on the License screen if you agree with the License 
Agreement.

Figure 71
Digital camera installation, fifth screen

Figure 72
Digital camera installation, sixth screen
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10. On the Installation screen, EOS utility will be installed. The results of 
the installation will be displayed. Click [Next].

11. On the Registration screen, you can register your camera if you wish. 
Registration is not required to connect your camera to Qbit-DB. Make 
your selection and click [Next].

12. When you are finished with the installation process, click [Finish].

Loading the digital camera driver

Before loading the digital camera driver ensure that your camera’s battery 
is charged.

To load the digital camera driver onto your computer, complete the 
following steps:

1. Locate the camera to USB cable that came in the camera box.

2. Plug one end of the cable into the camera, and the other end into an 
available USB port on your computer. Use the USB extension cable if 
needed.

3. Make sure that the camera is set to Auto mode.

4. Turn the camera on.

Figure 73
Digital camera installation, seventh screen
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5. The driver should automatically be installed onto your computer. The 
following message will appear, telling you that the driver has been 
successfully installed.

Connecting your camera to Qbit-DB

To connect your camera to Qbit-DB you will need to configure the EOS 
utility software. To configure this software, complete the following steps.

1. Open up the EOS Utility software. This software will need to be started 
each time you operate the digital camera with Qbit-DB.

This software may open automatically when you plug the camera into 
your computer and turn it on.

NOTE Your digital camera must be connected to the computer and turned on 
before you can access the EOS utility software.
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2. Click [Preferences...]

3. Under the Basic Settings tab, select Show main window under Startup 
Action.

Deselect all other options except Start EOS utility automatically when 
the camera is connected.

Figure 74
EOS utility

Figure 75
EOS utility, basic settings screen



Installation Installing a digital camera

Qbit-DB 157

4. Click on the Destination Folder tab. Under Destination folder, browse 
to Cubiscan > TempImages.

Deselect all option boxes.

5. When you are finished, click [OK] to exit the Preferences window. 

6. From the EOS utility software home screen, click [Camera settings/ 
Remote shooting]. This will bring up a window that allows you to 
capture images remotely using the computer. Minimize this window for 
the next few steps.

Figure 76
EOS utility, destination folder
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7. Open Qbit-DB and navigate to the Camera tab located under Tools > 
Options.

8. Under Digital camera options, enable the field Enable digital camera 
snapshots. Click [OK] when you are finished to close the Options 
window.

9. Enter the item number for the item that you want associated with the 
picture into the Item number field (primary field).

10. Maximize the remote image capturing window (shown below).

11. Click the black, round button located in the top right corner of the 
window. This should cause the digital camera to take a picture. Make 

Figure 77
Camera tab
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sure that the camera lens cover has been removed.

If the camera was connected to Qbit-DB successfully the picture should 
be displayed in the camera image window on the main Qbit-DB screen 
(shown below).

This remote picture taking method only needs to be used the first time 
to help the camera connect to the Qbit-DB software accurately. After 
using the remote method once, you should be able to take pictures 

Figure 78
Remote image capturing window
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using any method you prefer.

For further information on the settings available with the digital 
camera, see “Images” on page 64.

Parts list for the digital camera kit

Following is the parts list for the digital camera kit: 

Figure 79
Camera image window

Part No. Description Quantity/Unit

12461 USB Cable 1

13412 Tripod 1

13414 Integration Software (Included with Qbit-DB) 1

14267 Digital Camera 1
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APPENDIX B
FREQUENTLY ASKED QUESTIONS

This appendix contains some common questions about Qbit-DB. If, after 
reading this manual and reviewing this appendix, you still have questions, 
please contact Cubiscan.

Question: Do “updated records” that are exported contain data 
records from previous sessions?

Answer: Each record in the database is marked when it is updated and remains 
marked until exported. When exporting “updated records”, all records that 
are marked are included.

Question I am not able to edit the Length, Width, Height, and 
Weight fields. What should I do?

Answer: Select View from the menu and disable the Cubiscan fields read only 
option. This enables these fields to be edited.

Question: I am unable to communicate with the Cubiscan unit. What 
should I do?

Answer The troubleshooting steps for connecting via Ethernet, serial, and USB are 
listed below. For Cubiscans that do not have touchscreens, please contact 
Service and Support for assistance at 801.451.0500.

Ethernet

Without Ethernet to USB adapter (straight connection from the Cubiscan’s 
Ethernet port to the computer’s Ethernet port):

1. Make sure the Ethernet cable is securely plugged in to the Cubiscan 
and the computer and both systems are powered on.

2. On your Cubiscan, make sure the Ethernet checkbox is enabled. You 
can find this checkbox under the Configure > Operation tab.
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3. Verify the IP, Subnet, and port settings of the Cubiscan under the 
Configure > Ethernet tab. Make sure the IP address is 10.1.100.100, the 
Subnet address is 255.255.255.0, and the port number is 01050.

4. If you are using Qbit software, make sure you have entered the correct 
IP address of 10.1.100.100 and port number of 1050. Make sure the port 
is allowed by firewall and antivirus software.

5. On your computer, verify your IP and Subnet address in Control panel’s 
network and sharing center. The IP address should be 10.1.100.10 and 
the Subnet address should be 255.255.255.0.

6. If you still cannot communicate with the Cubiscan, you may have a bad 
Ethernet cable. Try using a different Ethernet cable if available. If this 
does not correct the problem, call Service and Support for assistance 
at 801.451.0500.

With Ethernet to USB adapter:

1. Make sure the Ethernet cable is securely plugged in to the Cubiscan 
and the Ethernet to USB adapter. Make sure the USB adapter is 
plugged into the computer.

2. On your Cubiscan, make sure the Ethernet checkbox is enabled. You 
can find this checkbox under the Configure > Operation tab.

3. Verify the IP, Subnet, and port settings of the Cubiscan under the 
Configure > Ethernet tab. Make sure the IP address is 10.1.100.100, the 
Subnet address is 255.255.255.0, and the port number is 01050.

4. If you are using Qbit software, make sure you have entered the correct 
IP address of 10.1.100.100 and port number of 1050. Make sure the port 
is allowed by firewall and antivirus software.

5. On your computer, verify the IP and Subnet address of the Ethernet to 
USB adapter in Control panel’s network and sharing center. The IP 
address should be 10.1.100.10 and the Subnet address should be 
255.255.255.0.

6. If you still cannot communicate with the Cubiscan, you may have a bad 
Ethernet cable or Ethernet to USB adapter. Try using a different 
Ethernet cable if available. If this does not correct the problem, call 
Service and Support for assistance at 801.451.0500.

DHCP Ethernet connection:

1. Make sure the Ethernet cable is securely plugged in to the Cubiscan 
and the network outlet.

2. Make sure your computer is connected to your network.
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3. On your Cubiscan, make sure the Ethernet checkbox is enabled. You 
can find this checkbox under the Configure > Operation tab.

4. Under the Configure > Ethernet tab, make sure the In use Ethernet 
and DHCP checkboxes are enabled.

5. Check with your network administrator and make sure Qbit (if 
applicable) and port 01050 are allowed by the firewall and antivirus 
software.

6. Verify the IP, Subnet, and port settings of the Cubiscan under the 
Configure > Ethernet tab. Make sure the IP and Subnet addresses 
match the ones you are entering into the Qbit software (if applicable). 

7. If you still cannot communicate with the Cubiscan, you may have a bad 
Ethernet cable. Try using a different Ethernet cable if available. If this 
does not correct the problem, call Service and Support for assistance 
at 801.451.0500.

Serial

1. Make sure the serial communications cable is properly connected with 
a NULL MODEM cable. 

2. Verify that the NULL MODEM cable is plugged into the correct 
controller box port. 

3. If your Cubiscan model is the Cubiscan 100, make sure that the port 
closest to the Cubiscan display is the port being used. Then try 
measuring an item using the Cubiscan display. Place an item on the 
Cubiscan platform and press MSR. If you see a -01- or ----- in the 
Length, Width, Height, or Weight fields, one of the sensors or scale 
may be causing a communication error. If this occurs, contact Service 
and Support for assistance at 801.451.0500.

4. Verify that the proper COM port is selected in the setup options in 
Qbit-DB. If there is still no communication, verify that the serial port on 
your computer is operational (refer to your computer’s documentation).
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5. If you are using a USB to serial adapter, check which COM port your 
computer is using. This information can be found under your 
computer’s Device Manager (see below).

In the example shown in the figure above, the prolific port was assigned to 
COM5. Make sure that you are using the same port number in Qbit-DB, 
located in the PC port # field under the Tools > Options > Cubiscan tab.

USB

1. Make sure the USB cable is securely plugged in to the Cubiscan and 
the computer and both systems are powered on.

2. If you can’t communicate with the Cubiscan, try using a different USB 
port on your computer.

3. If you still can’t communicate with the Cubiscan, you may have a bad 
USB cable. Try using a different USB cable if available. If this does not 
correct the problem, call Service and Support for assistance at 
801.451.0500.

Question: All of the records at the bottom of the Qbit-DB page have 
disappeared, how do I get them to show up again?

Answer Go to the Database menu found on the main window and select Default 
column order.

Figure 80
Device Manager
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Question When I export a .txt file and open it in Excel, each number 
has zeros preceding the actual number. How can I 
eliminate these zeros?

Answer Complete the following steps.

1. Export the file to a .txt file. For information on how to do this, see  
“Exporting a database table” on page 115. 

2. Open Excel and then open the desired .txt file using Excel (make sure 
that All Files is selected under the drop-down list located next to the 
File name field). 

3. The Text setup wizard will open and allow you to format the various 
columns (shown below).

NOTE
.csv files can be opened in Excel but will not open up the Text import wiz-
ard because .csv files are associated with Excel.

Question How can I move the camera image window?

Answer Click on the top left corner of the window and drag it to where you would 
like it.

Figure 81
Text Import Wizard
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Question When I am using an ODBC connection and the following 
error is received: ODBC transfer queue item not found, 
sequence number. How do I fix this error condition?

Answer Open the Cubiscan folder. Locate the file called ODBC Seq Num Errors.txt 
and rename it to ODBC Seq Num Errors.txt.old. Restart Qbit-DB.

If you have additional questions or require further help, please contact 
Cubiscan Service and Support for assistance at 801.451.0500 or at 
support@Cubiscan.com. 

mailto: support@cubiscan.com
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APPENDIX C
FIREDAC ADMINISTRATOR

FireDac administrator utility 

In order to better serve those customers with specific server requirements, 
Qbit-DB offers the FireDac administrator utility. This utility allows you to 
create server connections that lay outside of the default conditions 
established by Qbit-DB. For example, you may want to set up these 
connections to import or export data from Qbit-DB to a tables that reside 
on an outside server. 

If you are not familiar with your particular server needs, consult with a 
systems administrator. For best performance, it is advised to use default 
settings whenever possible. 

The FireDac administrator utility can be accessed by finding the Cubiscan 
folder in File Explorer. By default the Cubiscan folder will be in the root 
directory. You can also search for the folder in File Explorer.

Double-click the FDAdministrator application within the Cubiscan folder. 
This will launch the FireDac administrator utility.

Figure 82
FireDac main window
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Create a new connection

Right Click on QBIT_DEFAULT and select Connection definition. This will 
generate a new database connection with the default name 
ConnectionDef1. This name can be changed either by right-clicking on the 
new connection in the left side panel and selecting Rename.

Choose your Driver ID by selecting from the drop-down menu to the right. 
The Driver ID designates the database management system (DBMS) used. 
The correct DBMS must be selected for Qbit-DB to access your database.

The available options are MSAcc (Microsoft Access), MSSQL (SQL Server), 
MySQL, ODBC (Micro Soft Open Database Connectivity), Ora (Oracle), PG 
(PostgreSQL), SQLite, or TData (Teradata). Choose the Driver ID that 
matches the database you use. The connections parameter will differ 
depending on the DBMS used.

The value in the Database field shows the location of the database on the 
server. Your database administrator should have information on the 
parameters need to connect to your database. 

Figure 83
Connection parameters (MS SQL Server)
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Once the connection parameters are entered, replace the connection 
name in Master Data Connection Definition found in Tool > Options > 
Database connection. The default will be QBIT_DEFAULT. 

In some cases, the development location will need to be entered into the 
Schema name field to access certain database tables. The Schema name is 
the schema definition associated with the database. When entering the 
schema name be sure to include the “.” at the end of the name (e.g., dev.). 
If you are not sure if the schema name is needed, consult your database 
administrator.

SQL scripts

In order to export and import data from tables from an outside source such 
as an ASCII file, scripts may need to be written in order to ensure that the 
data is mapped properly to and from the source. Examples of these scripts 
can be found in the folder called Script examples within the Cubiscan 
folder. 

The Script examples folder can be accessed by finding the Cubiscan folder 
in File Explorer. By default, the Cubiscan folder will be in the root directory. 
You can also search for the folder in File Explorer.
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Along with these example scripts, Cubiscan has included templates found 
in the SQL scripts templates folder that can be accessed by finding the 
Cubiscan folder in File Explorer. 

MS SQL Server script templates are provided by Cubiscan for the use of 
database administrators. If you have questions about using the templates 
or do not see the template you need, please call Service and Support for 
assistance at 801.451.0500. 

While other database management systems can be used with Qbit-DB 
such as MySQL, examples and templates are not provided. It is up to the 
database administrator to set up these scripts.

Open Database Connectivity (ODBC)

The Open Database Connectivity (ODBC) allows for the transfer of data 
from your database to another. The ODBC tab is found in the Options 
window from the Tools menu. To activate this capability, check the box next 
to Enable ODBC.

Figure 84
Open database connectivity (ODBC)
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ODBC Data
Connection

Definition

Under the ODBC Data Connection Definition section there are fields to 
enter the location of the database they you wish to connect to. 

Connection name: This is the name that was created using the FireDac 
Administrator utility to connect to the ODBC data source name.

Schema name: This is the schema definition associated with the database 
and may be needed to access certain database tables. If included, the 
schema name should include “.” at the end of the name.

ODBC table name: Enter the name of the table you wish to connect to in 
this field.

Start FireDac administrator: Click this button to open the FireDac 
administrator utility.

Test/Open ODBC connection: Click this button to ensure that the ODBC 
connection is working properly.

ODBC
database

table merge
options

Once you have connected to a table, you may choose how you would like 
to merge data with the connected table.

Append Only: Existing items will not be updated when data is merged to 
the table. Only new items will be added.

Update only: Existing items will be updated when the data is merged, but 
new items will not be added to the table.

Append/Update: Existing items will be updated during the merge, and 
new items will be added to the table.
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